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1. Introduction 
 
 

 

PowerINSPECT Introduction. 
 
PowerINSPECT is a CAD based inspection solution package for use with 
many types of inspection hardware, including manual and CNC CMMs, 
portable arms, optical measuring devices and CNC machine tools 
(OMV) 
With a standard Windows application layout, PowerINSPECT allows the 
user to rapidly create a complete inspection, and automatically generate 
a high quality report using either HTML format or Microsoft EXCEL. The 
inspection reports can be customised to include pictorial, tabulated and 
statistical data, meeting the demands of design requirements and agreed 
International Standards. 
The software gives the user instantaneous results during the inspection 
and the onscreen reaction and detailed graphical displays give immediate 
feedback for each measured point. 

 
PowerINSPECT supports models created by other Delcam products or 
from neutral formats such as IGES.  If the relevant PS-Exchange 
translators are purchased PowerINSPECT will directly import data 
created by the majority of non-Delcam packages, such as CATIA, 
Unigraphics, SolidWorks, IDEAS etc. 

 
PowerINSPECT has a simple user interface, which is intuitive and easy to 
use. The learning curve is short allowing the operator to get the most 
from the measuring device in the shortest possible time. 

 
It must be noted that the examples given in these training notes are 
specific to the models used in the training course.  Therefore, it is the 
techniques that should be learnt, and adapted to the users own 
requirements. 
 
PowerINSPECT gives the User: 

 
• Comparison against all mainstream CAD formats. 
• Rapid alignment even for complex freeform shapes. 
• Inspection of user-defined sections. 
• The ability to inspect along the edge of a part. 
• Full Geometric Inspection capabilities. 
• Automatic creation of inspection features from CAD nominals. 
• A step-by-step Geometric Dimensioning & Tolerancing (GD&T) Wizard. 
• Point, wireframe and surface export for measured entities. 
• CAD manipulation - including surface offsetting (e.g. reverse side 

for sheet metal, spark gap for electrodes). 
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Starting PowerINSPECT 

 
• To load PowerINSPECT, double-click on the Desktop icon. 

 
Once loaded the screen should look as follows: 

 
 

 
 
 

When PowerINSPECT loads up, the Work Environment remains 
empty, until the user starts a new session.  When a new session 
begins more options become available in the Menu Bar, and a Graphics 
Window, Sequence Tree and Context-Sensitive Toolbar are 
automatically generated. These are summarized below. 
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Menu Bar 
The Menu Bar is located at the top of the main window. 

 

 
 
Clicking on a menu item opens a pull-down menu that contains submenus 
and commands. If a menu item is dimmed then it does not apply to the 
currently active document.  Some sub- menus contain additional sub-
menus, indicated by a small arrow to the right of the text. 
Clicking on an arrow generates a further list of command options.  
Clicking outside a menu box will cancel any command 
 
Main Toolbar 
The Main Toolbar is displayed at the top of the project window under the 
menu bar.  The tools allow the user easy access to the most frequently 
used PowerINSPECT menu items. 

 

 
 
Each Icon/Button corresponds to different functions, the definitions of 
which are given in the 
Glossary (Chapter 14), and by clicking on them their assigned task will be 
performed. 

 
Additional functions can be added to the Main Toolbar by either right 
clicking in the Main Toolbar area and choosing other menu items, or by 
selecting other functions (e.g. the CAD File Manager – see Chapter 3). 

 
Element Toolbar 
The Element Toolbar (left hand side toolbar) is used for the creation of 
Alignments and Geometric/Inspection Groups. 

 
This toolbar can vary according to the function that is chosen 
(this will be expanded upon in later chapters). 

 

The Comment Icon  can be used, for example, to provide 
another user with detailed instructions on how to perform an 
inspection, or how an inspection was performed. 

 
For instance, combining images and videos  inside a comment, 
can guide other users to specific areas for inspection. 

 
Please note that the Toolbars are Dockable, as they can be dragged to 
a new screen position if the user requires. 
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CAD Toolbar 
The CAD Toolbar (right hand side) contains the options to orientate 
and shade the CAD model. 

 
 
 
 
 
 
 
 
Labels displaying measured/selected data can be controlled from this Toolbar. 

 
 
 
 
 
 
 
 
 
 
Right-mouse button selecting in the Grey 
menu bar areas can toggle the visibility of all 
Toolbars. 

 
 
 
 
 
 
 
Small black arrows  under icons can 
be selected to display further options. 

 
 
 
 
Selecting Options… from 
the Tools menu allows 
the user to specify 
settings for various 
PowerINSPECT features. 
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Creating a New Session 

A new session can be started either from the File menu or directly 
accessed from the Main Toolbar. There are two options available. 

 

 Creates a new inspection document without loading a CAD model. 

 The New Document Wizard allows users to choose whether they 
want to open no CAD models, one model or multiple models. 

 
 
If a PowerINSPECT session (*.pwi) already exists, then the Open option 

can be used in the file menu, or the Open Button  on the Main 
Toolbar can be pressed. 

Note that this icon corresponds to that in the file menu. 
 
When a new session begins using the New Document Wizard, the user 
is guided through a step-by-step instruction. 

 

New Document Wizard  

• Select New Document Wizard.  
 

The first section opens the New Inspection Session window 
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The user can select from the options displayed. 
 
 
Measurement without CAD creates an inspection session without opening 
a CAD model. 

(This is the same as selecting new session  from the Main Toolbar.) 

Measurement with a single CAD part creates an inspection session 
using one CAD model. 
Measurement with multiple CAD parts creates an inspection session 
using several CAD models. 

 
• Ensure the option Measurement with a single CAD part is 
selected, then select Next to display the second page of the 
wizard. 

 
 
 
Within this window the user can specify the units that they wish to work 
in, applying offsets and specifying the tolerance for surface and edge 
points. Primarily, the CAD file/model location is loaded here. 

 
The CAD File is located by selecting , browsing for the 
file, and then selecting . 

 

Once the CAD File has been selected, it can be transformed (see Chapter 
3), or further CAD files can be added (i.e. for an assembly). Further 
models can be selected from within a  session using the CAD manager 
tab, or from the first page of the wizard. 

 
 

 
The user can then move on to the next section of the Wizard using  
Button. 
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Variables Window and the Report Template 
 
 

The Variables 
Window allows the 
user to select the 
Report Template 
they wish to output 
to. As with the CAD 
File selection the 
user chooses the 
Report Template 
File via the Browse 
Button. 

 
When browsing, the 
user has 2 options. 

 
 
 
 
 
 
 
PowerINSPECT 2010 has the ability to create 
Reports in 2 formats. 

 
 
 
 
 
 
 
 

The first allows the user to create 
a report using an HTML format.  
These reports are created directly 
inside the PowerINSPECT 
*.pwi file, and are accessible 
through the Report tab in the 
Area Selection Tabs area of the 
Graphics Window. 
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The second allows the user to 
create a  report using Microsoft 
Excel, thus allowing backwards 
compatibility for older versions. 

 
 
 
 
 
 
 
 
 

The entries can be directly 
edited by simply clicking on 
the required field, and editing 
the contents. 

 
 
 
 
 

To finish the process and begin the session, the  Button is 
selected. 
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Graphics Window 

 
With a new session now open, some changes can be seen in the 
PowerINSPECT Work Environment.  These include several new menus, 
a Graphics Window (seen here as the default CAD View, with a series 
of area selection tabs) and a Sequence Tree (pictured here with the 
CMM and PCS Datum Icons).  To the right of the Graphics Window is the 
Context-Sensitive Toolbars area (pictured here with the CAD view 
toolbar) whose toolbars change according to the selected area tab the 
user is operating in.  At the base of the screen is the Probe Status Bar 
(see Chapter 2). Note: Screen layout is for manual licence. 

 
 
 
 
 

Sequence Tree Context sensitive 
Toolbars area 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Graphics 
Window 

 
 

Area selection tabs 

 
 

Probe status bar 
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The Graphics window displays a number of tabs, including the CAD View tab where the 
user can view the CAD model and visualise the inspection they are carrying out.  There are 
five display tabs available: 

 
CAD View Where the CAD data, against which the user is inspecting, is displayed. 

 
Info Allows the user to view information about a selected Sequence Tree 

element. 
 

Dynamic Points PowerINSPECT displays this tab when the user uses dynamic points 
to create a Free Form Fit Alignment. 

 
Report Allows the user to view the Report in HTML format. 

 
Section PowerINSPECT displays a Section tab each time the user creates a 

Section Inspection Group. 
 
 
 

Views and View Manipulation 
Now that the new session has been created the user may view the CAD model in order to gain 
some visual information about the part.  To do this, the various views and their manipulation, 
need to be understood. 

 
Firstly though, the use of the mouse functions must be established. 

 
 
 

Mouse buttons 
Each of the three mouse buttons performs a different dynamic operation in PowerINSPECT. 

 
Mouse button 1: Picking and selecting 

 
 

This button is used for selecting items from the pull down menus, 
options within forms, and entities in the graphics area. 

 
It is also responsible for view manipulation depending on the 

setting used in the Set Mouse Button 1 View Mode . 
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Mouse button 2: Dynamics 
 

Zooming in and out: - Hold down the Ctrl key and mouse button 
2. Move the mouse up and down to zoom in and out.  Or 
alternatively, rotate the Scroll Wheel (if available). 
Pan around the model: - Hold down the Shift key with mouse 
button 2.  Move the mouse in the required direction. 
Zoom Box: - Hold down the Ctrl and Shift key, drag a box around 
the area to zoom into using the middle mouse button. 
Rotate mode: - Hold down mouse button 2 and move the mouse, 
the view now rotates. 

 
 

Mouse button 3: Dynamics, Special Menus & PowerINSPECT 
Sequence Tree Options 

 

Zooming in and out: - Hold down the Ctrl key and mouse button 
3. Move the mouse up and down to zoom in and out. 
Pan around the model: - Hold down the Shift key with mouse 
button 3.  Move the mouse in the required direction. 
Zoom Box: - Hold down the Alt key and mouse button 3, drag a 
box around the area to zoom into. 
Rotate mode: - Hold down the Ctrl and Shift keys, and mouse 
button 3, to rotate the view. 

 
 

When this button is pressed on its own it brings up a context sensitive menu based on 
whatever the mouse is over, such as the Sequence Tree, or the toolbar menus. 

 
 

Choosing Views 
View choice can be made in several ways using the View Menu, View Palette and in some 
cases using the Context-Sensitive Toolbar. In all cases the icons/buttons are the same and 
definitions of these can be located in the Glossary (Chapter 10, Page 74) 

 
The View Menu is accessed from the top menu bar and contains the 
Resize to Fit option, and a number of View Sub-Menus.  Each of 
these sub menus corresponds to a different group of views. 

 
The From views look at the model using particular axes, the ISO 
views are isometric and the Custom Views are user defined (which 
can be saved in this sub-menu). 

 
The Simulator and Probe Path menu options are for the CNC version 
of the software, with the other options relating to the CAD View Grid, 
and various Colour, CAD Mesh and Level changing options. 
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The View Palette shares these view-changing functions. 

This Palette ‘pops-up’ by clicking the arrow attached to the Select View Button  in  
the CAD View Toolbar and contains a series of buttons, which correspond to the same icons 
in the view menu. 

 
 

 
 
 

The 1, 2, 3, and 4 buttons are used to select the Custom Views, which can be saved using the 

corresponding save icon .  Rotations can also be triggered using the Arrow Keys on the 
keyboard, by dynamically moving the cursor using the Mouse Functions or by using the 

Rotations pop-up toolbar . The rotation axis is selected from the toolbar and the view then 
rotated incrementally by clicking on the icon 

 
 

Finally, if more than one session has been opened, the user can 
view all sessions in a single screen, using the Window menu.  The 
sessions can then be arranged according to the users preference. 
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The CAD View 
The CAD View within PowerINSPECT is where all the Inspection and Geometric information 
is viewed.  CAD inside this view can be seen in a variety of different guises. 

 
Models can be seen either with No Shading, 
Transparent Shading, or Solid Shading, 
combined with or without Wireframe. 

 
Shading changes are made through either the 
Shading Mode For Model pop-up toolbar 

button , which opens this toolbar 

, or by 
using the shortcut keys (W=Wireframe on/off, 
S=Shading on/off).   Some examples of these 
modes can be seen to the right and below. 

 
 

Wireframe Only 

 

  
Transparent Shading Solid Shading 

 
PowerINSPECT also has a function which 
allows the user determine the surface normal 
direction. 
Using the Highlight Back-facing Surfaces 

button , in combination with the shading, 
will show all reversed surfaces as bright red. 
This is useful for determining the direction 
needed for Surface Off-sets. 

The Surface can be reversed by using Surface 

selector  to select it 
first and then selecting 
Inverse Surface. (Right 
mouse click) 
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The Report Template 
As highlighted in the variables section, PowerINSPECT allows the user to select a Report 
Template they wish to output their data to.  If using the HTML format, the report is 
integrated into the PowerINSPECT work environment, and can be accessed at any time 
using the  Tab.  These reports can be customised to suit the customer’s needs. 

 

  

The Information Tab 
The Information Tab allows the user to view specific items for positional data, tolerances, 
deviation, error etc.  This can be displayed by selecting the item to be investigated from the 
Sequence Tree, and pressing the Info Tab.  The following is then seen: 
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PowerINSPECT Help 

 
PowerINSPECT comes complete with it’s own Help Document which is accessed via the 
Help Menu.  When faced with a problem, it is often best practice, to make the help menu 
your first port of call. 

 
• Select Contents from the Help Menu. 

 

 
 

• The Contents can be viewed, with each area having a specific sub-menu. 
Required definitions could also be found using the Search tab. 
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Changing The PowerINSPECT Appearance 
 
 

From the Tools Menu (right), the Options Menu allows the 
user to change the Working Appearance of PowerINSPECT. 

 
• From the Tools Menu select the Options Menu. 

 
 
 
 
 
 
 
 
 

Within the Display Options dialogue box 
the user can specify a number of items, 
including, the Colours of Entities, the Sizes 
of Points, Confetti or Edge Points and 
toggle on or off Displayed items such as the 
CAD Datum. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1.16 Issue PowerINSPECT 2010 Copyright © 2009 – Delcam plc 



PowerINSPECT 1. Introduction 
 
 

 

 
 

Device Connection 
 

Users starting PowerINSPECT for the first time may need to establish a protocol connection 
to the inspection device 

 
When starting PowerINSPECT for the first time, the Main Configuration Protocol 
dialogue box appears.  Before loading up, an active connection needs to be made to some 
form of inspection device. 

 
The protocol dialogue box can be opened manually from the File menu. 

 
• Select Tools ► Machine Connection ► Configuration. 

 

 
 

Configuration and Error Mapping 
 

If a connection has not been set up: 
 

• Choose the Select Button to 
open a list of Connection Protocols. 

 
• Select the required Protocol for 
the system that PowerINSPECT is to 
connect to (if unsure of this contact 
Delcam Support) and choose Ok. 

 
The correct Connection Protocol should 
now be set up. 

 
 
 

Although most users have no need to access this once initially 
set up, it should be noted that if the probe position is not as 
expected, or a connection cannot be made, checking the 
Configuration might provide some help. 
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Once opened the form can be checked for the Protocol Connection and for Error Mapping. 
Error mapping allows the CMM machine to compensate for Variations in Measurement over 
extended distances.  For the training exercises however, the small distances moved, means  
the error mapping is disabled. 

 
Note:  Do not alter the connection protocol unless an experienced user.  The original 
installation should have a connection already set up for the specific machine. 

 
Starting Set-Up 

• Select the Toggle Machine Toolbar   from the Main Toolbar. 
 

 

The Machine Toolbar appears.  Within this toolbar the user can Connect to  and 

Home  the machine, open the Tracking Box  and Change the Probe tool . 
This toolbar also has a status bar, indicating the status of the CMM.  In the case above it can 
be seen that the CMM is “Not Connected”. 

 
Making a Connection 

The Connection Icon , also indicates the connection status to the CMM, and is located 
at the right of the Windows Task Bar. 

• Select the Connection Button  from 
the Machine Toolbar (or alternatively, choose 
the Connection option from either the Tools►  
Machine Connection ► Connection. 

 
This will attempt to connect to the CMM, if successful the Not Connected with change to a 
Green Machine OK as above. (Note: The user will be prompted to move the probe head to A 
= 0, B = 0 for a manual CMM). 

 
The user may also be prompted to move the CMM to the home position (in most cases, this 
means all axes moved to their positive end stops, although machines do vary). 

• If prompted, Home the CMM by clicking on 
                                          

the Home Button  
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There are a number of conditions displayed in the Status Box on the Machine Toolbar. 

These are summarised below. 

 
 

When no document (session) is open, the Status box shows the status of the connection 
between PowerINSPECT and the measuring device: 

 
 

Status Description 
 

 
PowerINSPECT is not connected to the machine. 

 

 
PowerINSPECT is connected to the machine. 

 
 

When one or more documents are open, the Status box shows the status of the connection 
between the active document and the measuring device: 

 
 

Status Description 
 

 
 

Neither PowerINSPECT nor the active document 
are connected to the machine. 

 

 
 

PowerINSPECT is connected to the machine, but 
the active document is not connected. 

 

 
 

PowerINSPECT and the active document are 
connected to the machine. 

 
 

The Status box can also display the following information messages: 
 
 

Status Description 
 

 
The machine is not homed. 

 

 
 

The homing procedure has just completed 
successfully. 

 

It should be noted that the exact procedure will vary from CMM to CMM and Portable Arm. 
You should follow the prompts given on your own machine. Once connected the Probes can 
be changed and edited. 
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2. CAD Management 
 
 
 

 

CAD Data 
The manipulation of CAD Data within PowerINSPECT is very important for the user. 
Using the CAD File Manager the user can Add or Remove CAD files, Transform CAD 
data in relation to Workplanes and indicate Levels to be included in the inspection. 

 
Workplanes 
Users, who are unfamiliar with the CAD environment, need to understand the use of 
Workplanes.  The Workplane is the Datum for all the CAD creation, and positional values 
are taken from this Datum location. 

 
While these values might be what are expected for a component with a local workplane, 
components created in say the Aerospace or Automotive Industry might be created in 
relation to a General or World Workplane (e.g. the centre of the front axle of a vehicle – 
car line) and values could be metres away from the Datum.  This might not seem much, but 
because PowerINSPECT works in mm, a value of say, only 2m, would register 2000mm. 

 
 

A graphical representation of this Workplane can be seen 
on the right. 

 
The Workplane(s) seen within the CAD view can be one of two: 

 
1. The first is the PCS Datum Workplane.  This is 

the actual world workplane that the CAD data was 
created in relation to.  This will always lie in the 
same position relative to the CAD, even after 
Transformation. 

 
In the picture on the right, this workplane can be 
seen at the corner of the part. 

 
2. The second relates to the Machine Datum for the 

CMM machine being used. 
 

This Datum appears move (relative to the CAD) 
once the alignment is created. 

 
 

3. The third is merely a Graphical Representation of the workplane and, even if the world 
workplane lies metres away and off the screen, this workplane is always visible.  This 
allows the user to identify the axis directions of X, Y and Z. 

 
Note:  All Transformations are made with respect the first Workplane. 
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CAD File Manager 
The CAD File Manager is located using the Tab to 
the right of the Sequence Tree. 

 
When selected the window opens up to show the 
Parts folder and the User Levels area.  Double 
clicking on the item, or pressing the + icon, opens the 
item to a lower level. 

 
To the right it can be seen that a Headlamp model 
assembly has been opened, and contains three parts 
with one level, and one part with three levels.  Two 
further user levels have also been created. 

 
 

The coloured box indicates the Wireframe or Shaded Colour of the part and can be changed 
by left clicking on it, and assigning a new colour from the palette. 

 
The light bulbs indicate whether the level is displayed  or not  in the CAD View, and the 
tick box  includes or excludes the level from the CAD Context. These can all be switched 
on or off by left clicking on them. 

 
When the CAD File Manager is opened a corresponding toolbar appears at the top of the 
tab, with a number of functions that can be used to manipulate the CAD data. 

 
 

This toolbar enables the user to Add or Remove CAD files, 
Reset the User Levels, Edit the CAD Details, Show or Hide 
CAD Files and Detailed View. 

 

Choosing the Add button, or the 
Cad Details button brings up the 
Cad Details dialog box.  This box 
allows the user to locate (using the 
Browse button) CAD files and 
perform Transformations on 
them. 

 
The Transformations are used to 
orientate parts within the CAD 
View. 

 
To Transform any CAD data, the 
part must be defined in the 
Filename box. 
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Once the part is specified, 
pressing the Transformation 
matrix button will call up the 
Matrix dialog box.  Within this 
box the user can specify any 
transformation (Rotation, 
Translation, Mirror and 
Scale), by clicking on the 
desired button and entering the 
desired values. 

 
 

For example:  Clicking on the Rotation button will bring 
up the Rotation box.  The rotational axis can be specified 
(e.g. the X-axis) and the user can enter the angle they wish 
to rotate the part by (e.g. 90 degrees). 

 
When the user is happy with the transformation, pressing 
Ok will enter it into the central area of the Matrix dialog 
box. 

 
These transformations, once created, can be saved and loaded later, deleted, edited and tested 
all within this same box.  It must be noted that, to edit or delete a transformation it must first 
be selected in the central area of the Matrix dialog box (just by left clicking on the item). 

 
 

Summary and Detailed CAD View 
 

Using the Summary/Detailed View      
button on the CAD File Manager toolbar, 
the CAD information area can be expanded 
to show more information about the part files 
(see left). 

 
The information displayed includes any 
Transformations, the Levels, Part 
Locations and the Number of Entities that 
make up the part. 

 
The Extent values indicate the dimensions of 
the part, in relation to the workplane origin. 

 

Simply clicking on the  button again, 
will return to the data summary. 
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CAD Menu Options 
As well as the CAD File Manager, CAD edits can be made using the some of the options in 
the Menu Bar. 

 
 
 
 

Within the Measures menu lie two options that are 
relevant to the CAD management. 

 
The first is the Parameters option, which opens up a 
Parameters Edit box, and the second is the CAD Levels 
for Inspection option. 

 
 
 
 
 
 
 
 

Choosing the Parameters option opens up the 
Parameters Edit box.  Here a series of tabs can be 
seen that relate to different areas of 
PowerINSPECT. 

 
 
 
 
 
 
 
 
 

Choosing the CAD Levels for Inspection 
option, allows the user to specify which levels 
they wish to include in the inspection. 

 
Choosing an item and clicking the Selection 
Arrow Buttons moves the item in the chosen 
direction. 

 
 
 

The and buttons move singular items, and the and buttons move all 
items in the chosen direction.  The levels can be either predefined by the CAD or created within 
PowerINSPECT. 
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Level Edits 
CAD data within PowerINSPECT can be move around to different levels.  This is done 
using a combination of a selection tool and an option called group surfaces. 

 

By choosing the Surface Selector Button  in the Mouse Context Toolbar, the user 
can specify which surfaces they wish to move and to which level. 

 

 
 

Pictured above is a standard view of a part, with the CAD File Manager open.  Note it has a 
single level created in the file. 

 

To create a new level, choose the Surface Selector Button  in the Mouse Context 
Toolbar and draw a box around, individually pick or Shift Click the surfaces that require 
moving (below left).  These then become highlighted (below right). 

 

  
Create a Selection Box Highlighted Surfaces 
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By right clicking on the selection and choosing group 
surfaces from the local menu (see right), the 
corresponding dialogue box (see below) that appears 
allows the user to place the selected surfaces on a different 
level. 

 
 
 
 
 
 

The user can place the surfaces on either an existing level, or 
in this case, a fresh level. This fresh level (see left) has been 
called “New Level”, and the tick box confirms its creation. 

 
 
 
 
 

Once created the level appears in the user levels area of the CAD File Manager, and can be 
switched on  or off  using the light bulb (see below). 

 

 

This technique can be very useful if there is a large quantity of data in a view. Each layer has 
an associated colour, used when colour shading the model. The shading colour for a level 
may be changed by clicking on the small coloured box to the left of the level’s name. The 
new colour is then picked from the palette that appears. 
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What is an Alignment? 
Alignment of the part or component allows PowerINSPECT to match the relative positions 
and orientations of the CAD and/or Machine datum. An alignment is normally the first item 
or task in the inspection sequence. The type of Alignment strategy selected is normally 
dictated by the shape and which features can be used. 

Alignments are accessed by selecting the Alignment Sub-Menu  from the Element 
Toolbar. 

 

 
 

The most widely used Alignment strategies are outlined in this chapter. 
 
 

 
 
Introduction to Geometric PLP Alignment 
A Geometric PLP Alignment is an alignment based upon the relationship of a physical 
Plane, Line and Point (PLP), and CAD Defined Coordinates, which define the part in the 
X, Y and Z.  It is considered to be a more accurate method of alignment (compared to the 
Free Form Alignment – see later) because it works directly from CAD Nominal Values, 
and can be an easier method to understand. 

 
Generating a Geometric PLP Alignment – The Headlamp Example 
For this example the Headlamp CAD file is going to be used.  Using the methods, previously 
described in the course, for starting a new session: 

 

• Create a New Document using the Wizard  and select the method 

 
• Browse and Load DemoBlock2008.dgk. 

 
• Keep the Default Settings for Offsets and Tolerances, and choose Next 

 
In the Variables dialog box: 

 
• Browse for any chosen HTML Report Template (Excel could be used, 
but for this example HTML is to be used). 
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• Select Finish. 

The new session is now ready for inspection. 
 

Choosing the Geometric Elements 
Before the alignment can begin, a decision needs to be made on where the Plane, Line and 
Point are going to be aligned to, and what will determine these elements. 

 
The Plane 
With any Alignment the results are better if a greater area spread is used to define the 
aligning elements.  For this reason, the CMM Bed or Table will be used to define the Plane, 
as the model has a flat base, and all model planes are small. 

 
The Line 
Lines can be defined from square edges (Probed Lines) or from the Connection, or 
Intersection, of Measured Elements.  In this particular example the line is to be defined in 
the X-direction, using the Centres of Two Measured Circles on the part. Note: The line 
direction in PLP must be axial. 

 
The Point 
Because the Circles will have already been defined, the Centre Position of one of these will 
be used for the Point Position. 

 
To the left is the CAD File. 

 
 
 
 
 
 
 

Circle 1 

 
 
 
 
 
 
 
 

Circle 2 

 
Plane 

The Two Circles chosen are 
indicated (left), and the Plane 
will be the base area (shown). 
The Line will be between the 
Centres of Both Circles, and 
the Point will be taken from 
the Centre of Circle 1. 
Both circles and line will 
therefore be projected onto the 
base (plane) 

 
 
 
 

Creating the Geometric Elements 
With the position of the elements chosen it is now necessary to define the Geometric 
Elements to Probe. 

• From the Element Toolbar, choose the Geometric Group  Button. 
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The Geometric Group dialogue box appears 
and prompts the user to name the group and 
add a comment if required. 

 
• Name the group Geometric 
Group 1, and Untick the Output in 
Report box. 

 
• Leave everything else as Default 
and choose OK. 

 
 
 
 
 
 
 
 

Note: The Output in Report box was unticked because we are going to do an alignment 
which is not required in the report. 

 
The Element Toolbar automatically changes to the Geometric Group Toolbar, and it is 
from this that the Geometric Elements will be created.  However, before the elements are 
created, the measurement should be delayed to allow the user to create all the elements first. 

 

• Choose the Delay Measure Button  from the Main 
Toolbar or Measures Menu. 

 
This allows the user to Pause the measurement until told.  Otherwise, 
when the Free Form Alignment is created, PowerINSPECT will 
automatically move to the probing process. 

 
 

The Geometric Group Toolbar (left) is split into eleven areas.  For the 
purposes of this example only three will be used. 

 

These are the Planes , Lines  and Features . 

These satisfy all the criteria for the Geometric PLP Alignment. 
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The Plane 
The first geometric item to be created will be the plane. 

 

• Select the Planes Button , and choose the Probed Plane . 

The Probed Plane dialogue box appears, and 
prompts the user to give the plane a Name, 
set the Flatness Values and Normal 
Vectors, and its Centre Position.  The user 
can also add a Comment if required. 

 
Because this plane is to be probed, these 
values can be left as default, and the probing 
process will determine them. 

 
• Enter the name Plane 1 leave the 
other settings as Default. 

 
• Choose OK. 

It can now be seen that a Plane Icon  has appeared in the Sequence Tree an 
Exclamation Mark  next to the Plane, signifies that the alignment has not yet been 
measured. 

 
 
 
 
 

The Circles 
The Two Circles are required next, and creating them follows much the same process as was 
used to create the Plane, only from a different menu. 

 

• Select the Features Button , and choose the Probed Circle . 
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The Probed Circle dialogue box appears, 
and again prompts the user to give the circle 
a Name, its Centre Position and a 
Comment if required. 

 
The Circle form also asks for an Offset or 
Thickness value, a Plane to Reference to 
and the Diameter, Radius and Circularity. 
(On page 2 of form) 

 
• Enter the name Circle 1, and set 
the Reference Plane as Plane 1. 
Leave the other settings as Default. 

 
• Choose OK & Repeat. 

This option allows the user to accept the 
form and create a new item of the same type 
without the need to close the form and re- 
choose the item. 

 
 

Once the new form comes up (it will be 
identical to the previous form except for the 
name) fill in the following values. 

 
• Enter the name Circle 2, and set 
the Reference Plane as Plane 1. 
Leave the other settings as Default. 

 
• Choose OK. 

 
 
 
 
 

The two items  have now appeared in the Sequence Tree, named Circle 1 and Circle 
2, and again they have the Exclamation Marks  because they are unmeasured. 
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The Line 
The final Geometric Item that will be created is the Line.  As highlighted before, the Line is 
to be created between the Centres of the Two Circles, and therefore the Line Between Two 
Points option is required for the item. 

 

• Select the Lines Button , and choose the Line: Two Points . 

The Line: Two Points dialogue box appears, 
and is similar to the previous boxes.  It 
prompts the user to give the line a Name, its 
Direction Vector and a Comment if 
required. 

 
The form also asks for a Distance and Two 
Reference Points to pass the line through. 

 
• Enter the name Line 1, and set 
Reference Point 1 as Circle 1: 
Centre, and Reference Point 2 as 
Circle 2: Centre.  Leave the other 
settings as Default. 

 
• Choose OK. 

 
 
 

The Line has now been created and the Sequence Tree 
has been updated to include all the Geometric Items 
(left). 

 
 
 
 
 
 

In the CAD View, all the items can be seen, located at the origin 
(see right). 

 
Note:  This is the Pre-Probed default position set in the forms. 
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Probing The Geometric Items 
Once the Geometric Items have been created, and the Part is secured to the CMM 
Bed/Table, the probing process can begin. 

 
 
 

• Right Click over Any Item in the Sequence Tree to 
bring up the Local Menu (left). 

 
• Choose the Play All option. 

 
Alternatively 

• Choose Play All  from the Main Toolbar, or 
Measures Menu. 

Note:  Choosing the Play  option will only play the selected 
element.  Also, choosing Play All will only play unmeasured items. 

 
 
 

PowerINSPECT will progress into the Probing Screen, prompting the user to start probing 
the indicated Geometric Item. 

 
 
Full Screen Options Toolbar 
When moving into Full Screen Measure Mode a new toolbar appears at the right 
of the screen (by default – see right).  This is called the Full Screen Options 
Toolbar and contains the functions that are common to all measurement modes. 

 

The Toggle CAD Context Display Button , switches on and off the CAD 
levels that are active for the user to probe, and the Edit CAD Levels Used For 

Inspection Button  allows the user to choose the levels used. 

The Toggle Previous Measure Display Button , switches on and off all 

previously measured items in the view, and the Change Probe Button , 
opens up the Probe Database Editor, allowing the user to change probes and 
positions. 
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The Tracking Box Button  opens the Tracking Box, which displays the probe position 

in terms of CMM or CAD coordinates, and the Help Button  displays help about the 
Probing Box. 

 
 
 
Feature Probing Dialogues 

 
Also, when in Full Screen Measure Mode a Feature Probing Box appears which contains a 
series of button options across the top of it.  At any stage during the probing process the user 
can utilise these options available to them, which vary depending on the items being probed. 
For Geometric items, the following functions are seen. 

 

The first button is the Reset All Button , and simply resets all the points taken for the 

currently active item.  The second button is the Remove Last Button  and allows the 
user to delete the details of the last probed point, so that it may be probed again.  This is 
useful when a mistake has been made and the point needs to be re-probed. 

 

The third button is the OK Button  and allows the user (when they have finished 
probing the points or feature and are satisfied that they are accurate) to exit back to the main 
window, or simply accept the currently active item. 

 

The Cancel Button  exits the probing mode without applying any of the probed points 
of the currently active item (items that have been successfully probed and accepted remain 
measured though). 

The Tracking Button  displays the point about to be probed, in a view perpendicular to 
the point's normal. 

 

Auto calculate feature.  
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Feature Probing 
 

 
The first Feature 
Probing box appears 
asking the user to take 
a minimum number of 
points to define that 
feature. 

 
In this instance 
PowerINSPECT is 
asking for Three 
Points to define the 
Plane. 

 
Note:  The number of 
points taken is 
indicated at the top 
right hand side of the 
box. 

 
Using the CMM Bed as the Planar 
Surface: 

 
• Probe Three Points around the 
Part, on the CMM Bed. 

 
• When the points have been 

probed select the Green Tick        
to Accept. 

 
The process will then proceed to the next 
Geometric Item. 

With the Plane probed, PowerINSPECT moves to the next item. 
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The second Feature Probing box appears 
asking the user to take a minimum number 
of points to define Circle 1. 

 
However, rather than the minimum three 
points, Four Points will be taken for the 
circles, at the relative North, East, South 
and West Positions. 

 
This makes it easier for the user to place 
the probe, and gives an even spread of 
points. 

 
 

Using the Part itself: 
 

• Probe Four Points inside the 
13mm Diameter Circle highlighted in 
the screen. 

 
• When the points have been 

probed select the Green Tick  to 
Accept. 

 

 
 

• Repeat the process for Circle 2. 
 

Once all the probeable items have been 
probed, the Sequence Tree is updated 
(right), with all the items having lost their 
Exclamation Marks. 

 
It should be noted that the Line was not 
probed but its Exclamation Mark has 
gone. 

 
This is due to the fact that the Centres of 
the Two Circles determined the Line’s 
position. These have been probed, and 
therefore satisfy the measurement 
conditions. 

Note:  The probed diameter of 13.0427mm 
(approximately the 13mm expected). 

 

Note:  The Point will be defined as the Centre of Circle 1. 
 
 
 

 

3.10 Issue PowerINSPECT 2010 Copyright © 2009 – Delcam plc 



PowerINSPECT 3. Alignments 
 
 

 

Double Clicking on each item in the Sequence Tree, or clicking on the  Icon, will expand 
the item, revealing the basic information about it (see below left). 

 
The un-aligned items can be seen below, with 
Purple Wireframe, and Blue Shading, in the CAD 
View. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: If the probed items can’t be seen, press the Button to resize the screen to fit, 
because the items may lie some distance away at this point. 

 
A Geometric Alignment now needs to be created to align the Probed Positions with the CAD 
File. 

 
Generating the Geometric PLP Alignment 
In order to create the Geometric PLP Alignment, some CAD Nominals need to be known. 
These Nominals create the relationship between the Probed Positions and the CAD File, 
and orientate them in terms of the Cartesian X, Y and Z Coordinates. 

 
The deciding factors will be the Plane Height and Normal Orientation, the Line Direction, 
and the Point Position. 

If these values are unknown then the Geometry Explorer  may need to be used to 
select the Feature Locations (more about this later in the course), however for this particular 
part these values are known. 

 
The Plane is to be set as the Z-Plane, at a Height of -45mm Note:  All items have been 
projected on to this plane), and the Line follows in the X+ Direction.  Finally the Point is 
the position of Circle 1 which is X = 56.489, Y = 22.640, Z = -45. 
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A Geometric PLP Alignment can now be created using these values. 
 

• Move up the levels  until Geometric Group 1 is Closed. 

• From the Alignments Sub-Menu icon , in the Element Toolbar: 

• Choose the Geometric PLP Alignment button . 

The Geometric PLP Alignment 
dialogue box appears and prompts the 
user to define the Plane, Line and Point. 

 
Note: Where there is only one item (e.g. 
One Plane), the pull down menu on the 
right hand side will only have the one 
option. 

 
 
 
 
 
 

• From the pull-down menu on the right hand side, set the Plane as Plane 1, 
and set the Orientated Normal to the Z/Z+ Direction. 

 
• Set the Line as Line 1, and set the Orientated Direction to the X/X+ 
Direction. 

 
• Finally, set the Point as Circle 1: Centre, and the Point Coordinate 
values as X = 56.489, Y = 22.640 (Circle 1 position) and Z = -45 (Plane 
height). 

 
• Choose OK to accept the form. 

 
 

All the criteria for the Geometric PLP 
Alignment have now been satisfied, and 
the alignment can be seen in the Sequence 
Tree. 
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To the left it can now be seen 
that the CAD View has been 
updated, with the Geometric 
Alignment now positioned 
correctly. 

 
 
 
 

To the right is a view of the 
model from Above (looking 
down the Z axis). 

 
This clearly shows the 
alignment, which can be seen 
more closely in the Zoomed 
View of the bottom right hand 
corner (below). 

 
 
 

To test the alignment is correct, (if probe tracking is available on the system) move the probe 
around Key Points on the part and check the Graphics Window to see if the representation 
of the probe is in the same place (see below). 

 
 

Any variation seen here, points to either an incorrect alignment, a failure in the probing of the 
items or an incorrect (or poor) part in relation to the CAD. 
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Assuming that the alignment is correct, a Surface Inspection Group needs to be produced, 
for the Report.  The creation of these Surface Inspection Groups is covered later. 

 

• Save the File  in any chosen location (e.g. C:\Temp). 
• Name the file GeometricPLP.pwi 
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Although Free Form Alignment is considered to be the least accurate method of alignment 
(because it relies heavily on the skill of the user) it is sometimes the only option if there are 
no clearly definable features for which CAD values are known (such as flat planes, circular 
forms etc). 

 
Generating a Free Form Alignment 
For this example the DemoBlock2008 file is going to be used. Although there are a number  
of geometric features on this part, these will be ignored to assume there are no features. Using 
the methods previously described in the course for starting a new session: 

 

• Create a New Document using the Wizard  and 
select . 
• Browse for Demoblock2008.dgk. Open this file. 

• Keep the Default Settings for Offsets and Tolerances, and choose Next. 
 

In the Variables dialog box: 
 

• Browse for a Report Template (Excel or HTML) and Extract Variables. 
 

• Select Finish. 
 

The new session is now ready for inspection. 
 
Choosing the target positions 
When performing a Free Form Alignment the user needs to study the CAD file, and/or the 
physical part, carefully in order to gauge where to take the probed positions.  For a Free  
Form Alignment the part needs to be effectively ‘held’ in position in all three axes (X, Y and 
Z).  This holding should occur such that the part cannot move in a space through any 
translation or rotation. 

 
Taking the CMM Bed as the surface to ‘pin’ the part down to, the user needs to choose a 
realistic minimum of Six or Seven Points (this can be as low as four but the alignment is less 
accurate – in this case Seven will be used), 3 in the Z direction, 2 in the X direction and 2 in 
the Y direction.  It is important for the user to place these points in positions that will be 
easily found on the physical surface, such as in line with other parts of geometry, or key 
surface points.  These will guide the user when aiming for the probing positions. 

 
Once these positions have been decided it is time to create a Free Form Alignment. 
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• From the Alignments Sub-Menu icon , in the elemental toolbar: 

 
• Choose the Free Form Alignment button . 

 
Once this button has been selected the Dynamic Points Editor Toolbar (left) 
appears on the right-hand-side of the screen. 

 
It is this toolbar that allows 
the user to create the Free 
Form Target Points, and 
manipulate them in terms of 
their Positions, Normal 
Directions and Offset 
Values. 

 
Note:  This toolbar can also 
be accessed from the CAD 
View toolbar using the 
Dynamic Points Editor 

Button , and it’s edits 
from the Tools Menu 
(right). 

 

• The Target Button  should be selected by default. 

Holding the cursor in the CAD view, shows it has 
now changed to a Target Sight.  This allows the user 
to select the points on the CAD surface that are going 
to be aimed for in the probing process. 

 

Points are selected by simply double clicking on the 
surface of choice. To the right it can be seen that the 
representation of the point can vary according to the 
view. 

 
 

Directly 
Above View 

 
 

Isometric 
View 

 

• Carefully choose a series of key points (in this case Seven - remembering 
3 in Z, 2 in X and 2 in Y) on the Physical Part surface that can be easily 
aimed for.  Use Key Features to aim for such as Lines, Indents, Corners 
and even Projected Aiming Positions on the part. 

 
The points chosen on the Physical Part now need to be re-produced on the CAD file within 
PowerINSPECT. 
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• Replicate the points chosen on the Physical Part within the CAD View. 
Do this by double clicking the Target cursor on the chosen surfaces to define 
the 7 Points for alignment. 

 
 

With the Target Points selected, the CAD View should look something like this: 
 

 
 

Although these points have been selected, they can still be manipulated in terms of their 
position and orientation, or even deleted and re-chosen. 

 
Holding the Target Cursor over any of the chosen points, changes the cursor to a hand , 
and allows the user to select and move the point around the surfaces using Dynamic Points 
Selection.  This can aid the user finding probed positions that are more easily aimed for 
(lining up with features etc.). 

 
The Dynamic Points Selection also lets the user choose the points to be manipulated using 
the other Dynamic Points Editor Toolbar functions. 

 

Using the Swap Normals Button   
allows the user to reverse the direction of 
the points. 

 

This can be useful if the user-defined point 
has been created in the wrong direction, 
such that the probed point is in an 
inaccessible position (e.g. the underside of a 
surface). 

 
 
 

Normal To Surface Normal Reversed 
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Using the Switch Surface/Edge Point 

Button  allows the user (if the point 
chosen is close enough to the edge) to flip 
the surface point onto the edge. 

 
This would be used when edge points are 
required rather than surface points. 

 
Note the change from an S (Surface) to an E 
(Edge) on the point label. 

Using the Apply Offset Button  
allows the user to set an offset value for the 
probed position. 

 
This is especially useful for inspecting 
pressings, whereby a known uniform 
thickness of material allows user to inspect 
the underside of a pressing, taking into 
account that thickness (i.e. the Offset) 

 
 
 

Surface Point Edge Point 
 
 

  
Without Offset With Offset (Value 

in Brackets) 
 

Once the Target Points have been selected and manipulated the Free Form Alignment can 
be created ready for probing. 

 

• Choose the Delay Measure Button  from the Main Toolbar or 
Measures Menu. 

 

• Select the Create Free Form Alignment Button  from the toolbar. 

 
Free Form Alignment dialogue box 
appears indicating the Positional 
Coordinates of each chosen point, the 
Surfaces they lie on, and the Offset values. 

 
Within this box the user can specify the 
Point Projection Proximity Criteria, 
which defines the surface area of search 
around the probe. 

 
 
 

• Increase the Projection Proximity Criteria to 3mm and choose OK. 
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Looking at the Sequence Tree a new item can be 
seen in the Definition area. 

 
This is the Free Form Alignment created from 
the Target Points, and will be used for probing 
the part. 

 
 
 

Note the Exclamation Mark  next to the Free Form Alignment 1, 
which signifies that the alignment has not yet been probed or played. 

 
• Select the Free Form Alignment 1, and right click on 
it to bring up the Local Menu (see left). 

 
• Choose the Play option. 

 

Alternatively use the Play  button from the Main Toolbar. 

This moves the user into the Probing Screen allowing the user to 
probe the pre-selected Target Points. 

 
 
 
Probing The Part 
Once into the Full Screen Measure Mode (and with the Part secured) the Probing Process 
can occur. 

 
Within this screen a Probing Box appears, with the target number shown (e.g. DS 1) and a 
series of probing option buttons, similar to those seen in the Geometric PLP Alignment 
(Chapter 4).  These buttons are identical, except that the Reset All has gone, and the 

Parameters Button  (which shows 
the CAD Context and Proximity Criteria 
for the probed points) is now shown. 

 

The Dynamic Point Targets  appear 
for the user to aim for (see right), and this is 
where the skill of the user comes in, getting 
as close to the targets as possible. 

 
They appear in sequence order and as each 
one is probed the next one appears on the 
screen. 
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• Probe the 7 Points to complete the alignment. 
 

Note:  Always remember to check the screen at each point to make sure the correct position 
is being probed.  To achieve a more accurate result aim for within +/- 3mm of the Target. 

 
 
 

Once all of the points have been probed, the 
Probing Screen indicates that there are no more 
points to take (see right). 

 
 
 

• When the points have been probed select the Green Tick  to Accept 
the Alignment. 

 
PowerINSPECT will then run through a series of 
iterations, to calculate the Alignment, with respect 
to the points probed by the user. 

 
The form to the left demonstrates this, and once 
completed, the will automatically exit the Full 
Screen Mode.  The less time this takes, the better 
the alignment tends to be. 

 
 
 

The Free Form Alignment has now been created. 
 

Note:  The Sequence Tree has been updated , and 
the Exclamation Mark  has disappeared (see right). 
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The Demoblock2008 part has now been 
aligned using the Free Form Alignment 
method. 

 
To check this alignment (if probe tracking is 
available on the system) move the probe 
around Key Points on the part and check the 
Graphics Window to see if the 
representation of the probe is in the same 
place (see right). 

 
If not, it may be necessary to either re-probe 
the part, or check the probe configuration for 
error mapping. 

 
 
Generating a Surface Inspection Group 
Once the part has been correctly aligned to the CAD file the next stage is to create a Surface 
Inspection Group.  This first group will be used to check the accuracy of the Free Form 
Alignment, and be used to improve the alignment using the Best Fit Analyser.  It is 
therefore not necessary to include this initial group in the Report. 

 
Note: Surface inspection will be covered in greater detail in the next chapter 

 

• Make sure the Delay Measure Button  is pressed On. 

• Create a Surface Inspection Group using the  button. 

• Keep all the Default Settings (except 
untick the Output in Report option and set 
the Minimum No. of Points as 12) in the 
Surface Inspection Group form and 
choose OK. 

 
 

• Right click over the Surface Inspection 

Group Icon  that has now appeared 
in the Sequence Tree and select Play. 

 
When the Probing Screen appears: 

 
• Probe 12 surface points on the part, 4 in Z, 4 in X and 4 in Y keeping a 
wide spread. 
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As the points are probed, the Surface Points on the Fly 
data box displays the deviation of the measured points. 

 
If no points are being registered it may be necessary to 
increase the proximity criteria to help detect them. 

 
 

• Once 12 points have been taken, choose OK . 

It can be seen that the Sequence Tree has now been updated, with the Surface Inspection 

Group icon  having lost the Exclamation Mark 
Once the Surface Inspection Group has been created, 
a quick check needs to be made of the Group. 

 
• Open the Surface Inspection Group to 
verify that 12 points have been taken (if less 
than 12 were taken, then the Exclamation 
Mark will remain). 

 
• Note the Spread of the deviation of the 
points. 

 
If the points seen in the Surface Inspection Group 
have a wide deviation, it may be necessary to re-probe 
the alignment.  However, the Best Fit Analyser may 
be able to correct this, but the key is in recognising the 
whether or not a Best Fit will work. 

 
For example, if positive deviation can be seen on one 
side of the part, and negative deviation on the other 
side (each of the same value) then this points to a slight 
Translation.  Similarly, opposites around an axis will 
indicate a Rotation.  If this sort of pattern can be seen, 
then a Best Fit will improve the results. 

 

Generating a Line Of Best Fit 
Because of the high dependence on the skill of the user, a Free Form Alignment may need 
some fine-tuning in order to generate a better alignment.  PowerINSPECT contains a Best 
Fit Optimisation option, which allows the user to generate a line of best fit between the 
probed points, and hence align the CAD Data and the Physical Part more accurately. 

 
Note: The Best Fit Optimisation option should only be used on the Free Form Alignment. 
Attempts to use it on an alignment based on geometric data may cause a distortion of the 
results.  In addition to this it should only really be used once on each Free Form Inspection. 
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For this example a Best Fit Optimisation is going to be applied to the newly created Surface 
Inspection Group. 

 
 

• Move Up One Level  in the Sequence Tree so that the Surface 
Inspection Group is closed.  Highlight this inspection group and choose the 

Best Fit Optimisation Button . 

 
This will open the Edit Best Fit definition dialogue box. 

 
 

This box allows the user to Name their Best 
Fit line, define the Application Method, and 
choose the Elements they wish to apply it to. 

 
• Name the Best Fit BestFit 1. 

 
• Set the application method to 
Translation and Rotation. 

 
• Choose the Inspection Group 1 
from the Available Elements area, 
and select it using the  Button. 

Before choosing OK it is best to apply the 
optimisation to the chosen elements. 

 
• Choose Apply, followed by OK. 
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Choosing OK progresses to the Best Fit 
Analyser (see left). 

 

Note:  If the Delay Measure is on , 
then it will be necessary to play the Best 
Fit once created.  Simply right-click on the 

Best Fit Icon  in the Sequence Tree 
and choose play to start the Best Fit 
Analyser. 

 
 

A graphical display of the current points’ deviation is given (green line) along with the 
Information used for the Calculation of the Best Fit (see above left). 

 
• Leave the Default Settings and choose the Go Step! Button. 

 
The Best Fit will now be applied to the data. 

 
 

To the right it can now be seen that the Best 
Fit Optimisation has been applied to the 
data and the new deviation graph (red line) 
fits closer to zero. 

 
• Choose OK to accept the 
Optimisation. 

 
The Best Fit has brought the results closer to 
zero creating a more accurate alignment. 

 
Note:  Some results may be anomalous and 
may need modification or further inspection. 

 
 

• Re-open the Surface Inspection Group to verify that the deviation results 
have improved. 

 
 

With the alignment created, and best fitted, subsequent Surface Inspection Groups can now 
be taken.  Since all items created are done so with respect to the Best Fit, further best fitting   
is not required.  Should the results of the alignment not be accurate, it may be necessary to re- 
align the part though. 
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Introduction to RPS Alignment 
The Reference Point System (RPS) Alignment was a technique developed by Volkswagen 
and has now become an industry standard for inspection.  As an alignment technique, its 
method lies somewhere between a Free Form Alignment and a Geometric Alignment, 
combining the benefits of both, with the ability to accept Geometric Positional Data and 
Surface Points. 

 
For the purposes of this training course, the use of Geometric Data will be emphasised, 
utilising the Geometry Explorer to find positional points in the CAD File. 

 
Generating an RPS Alignment 
Again, for this example, the Headlamp CAD file is going to be used.  Using the methods, 
previously described in the course, for starting a new session: 

 

• Create a New Document using the Wizard  and 
select . 
• Browse for Demoblock2008.dgk. Open this file. 

• Keep the Default Settings for Offsets and Tolerances, and choose Next. 
 

In the Variables dialog box: 
 

• Browse for any chosen Report Template (Excel or HTML), and Extract 
Variables. 

 
• Select Finish. 

 

Choosing the Geometric Elements 
As with the previous methods, a decision needs to be made on which Geometric Elements 
will determine the alignment. 

 
In this example, the part is to be aligned using a series of probed circles, each with their own 
locally probed plane.  The Centres of these Circles will then be used to determine the RPS 
Alignment. 

 
To create these positions, the Geometry Explorer will be used. 
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The Geometry Explorer 
 
 

 

To measure/select an item, click on the  
Button. 

 
Then simply hold the cursor over the required 
item until it’s wireframe highlights (a colour 
change will be seen to yellow) and left click the 
item. 
The chosen item now becomes highlighted in red 
(see right), with its details displayed in the 
Geometry Explorer. 

 
To the left, the blank Explorer can be 
seen.  As each Geometric Item is 
selected its details appear in that 
window. 
The Geometry Explorer can be used in 
two distinct ways. 
The first is as a measuring device, 
providing CAD Nominals from the file, 
for Geometric Alignments.  The second 
is as a selection tool, selecting 
Geometric Items to place in the 
Sequence Tree for probing at a later 
stage. 

 
Note: The Geometric Explorer and 
Features Tabs can be hidden by toggling 

 from the top of the Sequence Tree. 
 

 

 
 

The details are displayed in the top 
portion of the explorer, and by moving 

down the levels (using the  icon), the 
user can view and copy specific values, 
like the Arc Centre Point for example. 

 
These values can then be used to 
determine CAD Nominals for say a 
Geometric PLP Alignment. 
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Note:  The Geometry Explorer selection choice can 
be altered, by right clicking in the graphics window. 
This brings up a local menu where the selection 
criteria can be changed, e.g. from Wireframe to 
Points. 

 
 

In this chapter, the Geometry Explorer is going to be used to select the geometric items to 
be probed. 

 
As highlighted before, the part is to be aligned using a series of probed circles, each with 
their own locally probed plane.  The circular holes are located at each corner of the part. 

 
 
 
 
 
 
 
 
 
 
 
 

Circle 2 

Circle 1  
 
 
 

Circle 4 

 

• Orientate the 
view so that all the 
circles can be seen 
(e.g. an ISO 2 
View). 

 
• Select the Delay 
Measure Button. 

 
. 

 

Circle 3 
 
 

• Select Wireframe Checker  
• Ensure Wireframe is selected from the local menu. 
• Select the top wireframe circle of the hole at circle 1 (turns red in colour). 

 
 

• Ensure Linked to Most 
suitable plane is selected. 

 

• Select  to accept the feature. 

Note: If an individual plane (or correct) is not assigned to a 
selected feature, the option New Probed Plane can be 
selected before accepting. 
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By pressing the  Button, PowerINSPECT creates a 
Plane and Circle to be probed.  This can be seen in the 
second portion of the Geometry Explorer (see above) and in 
the Sequence Tree (see right). 

 
Note the Exclamation Marks  next to the Geometric Items, 
which again signify that they have not yet been probed or 
‘played’. 

 
 
 
 

Looking at the CAD View the created Local Plane and 
Circle can also be seen. 

 
 
 
 

• Repeat this process for the other three Hole Circle Wireframes. 
 
 

 
 
 

Once created, the Sequence Tree displays the eight items (four Planes and four Circles), 
which can also be seen in the CAD View (see above). With the part securely fixed to the 
CMM bed, these items are now ready to be probed. 
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• Right Click over Any Geometric Item in the 
Sequence Tree to bring up the Local Menu (right). 

 
• Choose the Play All option. 

Alternatively 
 

• Choose Play All from the Measures Menu, or the Play 

All Button  from the Main Toolbar. 

 
 

As with the Geometric PLP Alignment, 
the first Feature Probing box appears 
asking the user to take a minimum number 
of points to define that feature. 

 
• Probe three points around the 
Local Plane shown on the screen. 

 
 
 

• When the points have been 

probed select the Green Tick      
to Accept. 

 
The process will then proceed to the next 
Geometric Item. 

 
• Continue the probing process 
until all items have been probed, 
making sure to probe them in the 
order that they are shown. 
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As with the Geometric PLP Alignment, once all 
the probeable items have been probed the  
Sequence Tree is updated (right), with all the items 
having lost their Exclamation Marks. 

 
 
 
 
 
 
 
 
 
 

The CAD View now contains the probed 
planes and circles, but these require an 
alignment. 

 
An RPS Alignment will now be used to 
align the CAD Data to the Physical Part. 

 
Note: If the probed items can’t be seen, 

press the  Button to resize the screen 
to fit, because the items may lie some 
distance away at this stage. 

 
 
 
 

Generating an RPS Alignment 
 

• Move up the levels  until Geometric Group 1 is Closed. 

• From the Alignments Sub-Menu icon , in the Element Toolbar: 

• Choose the RPS Alignment button . 
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The RPS 
Alignment dialogue 
box appears and 
prompts the user to 
define the items for 
the alignment. 

 
The items used for 
alignment are 
selected via the Pull 
Down Menu. 

 
Once an item is 
chosen other items 
can be added using 
the  icon. 

• Leaving the Name and Local Datum as Default, choose the Circle 1:: 
Centre to define the first position from the Pull Down Menu. 

 
• Select the  Icon, to create a new Pull Down Menu. 

• From this new Pull Down Menu choose the Circle 2::Centre to define the 
second position, and again select the  Icon. 

• Repeat the process for the Circle 3 and 4 Centres. 
 
 

The form should look similar to 
that on the right. 

 
Note: The Tick Boxes allow the 
user to lock and unlock axes 
relative to particular items – thus 
the user can effectively create a 3- 
2-1 alignment, by ticking and 
unticking the boxes. 

 
• Choose Apply and OK. 
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PowerINSPECT aligns 
the probed positions to the 
CAD points given, 
satisfying X, Y and Z 
coordinates. 

 
To the right it can now be 
seen that the CAD View 
has been updated, with the 
Probed Items having been 
aligned to the CAD Data. 

 
 
 
 
 

All the criteria for the RPS Alignment have 
now been satisfied, and the alignment can be 
seen in the Sequence Tree. 

 
 
 
 
 

To check the alignment has worked, choose a 
variety of views and zoom into the aligned 
items to see if they match up. 

 
To the left can be seen a view looking down 

the Z-axis , zoomed into one corner. 
The alignment can clearly be seen here. 

 
As before, to test the alignment is correct, move the probe around Key Points on the part and 
check the Graphics Window to see if the representation of the probe is in the same place. 

 
If the alignment is correct, Inspection Groups can then be produced. Inspection will be 
discussed in the next chapter. 
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Introduction to Best Fit from Points Alignment 
 

This technique can be used to align from three or more points for which the CAD coordinates 
are known. PowerINSPECT uses these points that have been probed as geometric elements to 
carry out a 'best fit' to the rest of the CAD data. This method allows you to modify the 
alignment later if necessary, by amending the details of the geometric elements. 
Before you use this alignment strategy you must have created geometric elements that 
provide at least three points. Points include centres of geometric elements, such as the centre 
of a circle or sphere. You must also know their position in the CAD data: if you don't have 
this information, you can extract the coordinates using the Geometry Explorer tab. This 
method will be shown below. 

 
NOTE: A Best Fit alignment can produce the same results as a Three Spheres alignment if 
three spheres are used to define the three points. 

 
 

Generating a Best Fit Alignment using Geometry Explorer 

• Create a New Document using the Wizard  and 
select . 
• Browse for Demoblock2008.dgk. Open this file. 

• Keep the Default Settings for Offsets and Tolerances, and choose Next. 
 

In the Variables dialog box: 
 

• Browse for any chosen Report Template (Excel or HTML), and Extract 
Variables. 

 
• Select Finish. 

 

Choosing the Geometric Elements 
As with the previous methods, a decision needs to be made on which Geometric Elements 
will determine the alignment. 
In this example, the part is to be aligned using a series of probed circles, each with their own 
locally probed plane.  The Centres of these Circles will then be used to determine the Best 
Fit Points. 

 
Similar to the previous RPS method, the Geometry Explorer will be used in conjunction 

with the Wireframe Checker.  
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Circle 1 

 
 
 
Circle 2 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Circle 3 

 
 
 
 
• Orientate the 
view so that all the 
circles can be seen 
(e.g. an ISO 3 
View). 

 
• Select the Delay 
Measure Button. 

 
. 

 
 
 
 

• Select Wireframe Checker 
• Ensure Wireframe is selected from the local menu. 
• Select the top wireframe circle of the hole at circle 1 (turns red in colour). 

 

• Ensure Linked to Most suitable plane is 
selected. 

 

• Select  to accept the feature. 

Note: If an individual plane (or correct) is not assigned to a 
selected feature, the option New Probed Plane can be 
selected before accepting. 

 
 

By pressing the  Button, PowerINSPECT creates a 
Plane and Circle to be probed.  This can be seen in the 
second portion of the Geometry Explorer (see above) and in 
the Sequence Tree (see right). 

 
Note the Exclamation Marks  next to the Geometric Items, 
which again signify that they have not yet been probed or 
‘played’. 
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Looking at the CAD View the created Local Plane and 
Circle can also be seen. 

 
 
 
 

• Repeat this process for Circle 2. 
• Select the Circle 3 Wireframe. From the Geometry Explorer Tab change 

the Circle option to Single Point Circle before accepting the Feature . 
 

  

 
Once created, the Sequence Tree displays the six items (three Planes two Circles and a 
Point), which can also be seen in the CAD View (see above).  With the part securely fixed to 
the CMM bed, these items are now ready to be probed. 
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• Right Click over Any Geometric Item in the 
Sequence Tree to bring up the Local Menu (right). 

 
• Choose the Play All option. 

 

Alternatively 
 

• Choose 

 
 

All from the Measures Menu, or the Play 
 

All Button from the Main Toolbar. 
 

• Probe all features as directed. 
 
 
 

Generating a Best Fit From Points Alignment 
 

• Move up the levels  until Geometric Group 1 is Closed. 

• From the Alignments Sub-Menu icon , in the Element Toolbar: 

• Choose the Best Fit From Points Alignment button . 

Point 1/3 is displayed.  

• Ensure Circle 1: Centre is displayed otherwise select it from the drop 
down list. 

 
X, Y and Z Coordinates can be typed in for Circle 1: Centre. Alternatively, as the nominal 
values have been extracted using Geometry Explorer, these coordinates can simply be loaded 
in. 
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• Select  to load in the nominal values for the circle centre 

 
 

Note: You can make the first point a Hard Point by 
clicking on the check box. This means that 
PowerINSPECT will match the geometric point to 
the CAD nominal exactly rather than trying to 'best 
fit' it with the other features. This option will not be 
used in this example. 

 
 
 

• Select  to move to display Point 2/3. 
• Ensure Circle 2:Centre is shown before selecting  

• Select  to move to display Point 3/3. 
• Ensure Point 1:Centre is shown before selecting  
• Select OK to create the Best Fit Alignment. 

 
A minimum of three points is required for the alignment. If required, further points can be 
added by selecting New . 
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4. Inspections 
 
 
 

 

Introduction to Inspection 
 

Following a suitable Alignment as described in the previous chapter, the part can now be 
inspected against the CAD data. This will highlight the accuracy and error (deviation outside 
defined tolerance) of the part, assuming the CAD data is correct. This chapter highlights the 
main inspection techniques available in PowerINSPECT. 

 
The Tolerance values, through which the Surface Inspection Groups operate, can be 
changed globally (though the use of the Start-up Wizard, or Measures>Parameters menu 
option), or individually in each Surface Inspection Group. 

 
 
 

 

4.1 Surface Inspection Group – Points on the fly. 

• Create a New Document using the Wizard  and 
select . 
• Browse for Demoblock2008.dgk. Open this file. 

• Keep the Default Settings for Offsets and Tolerances, and choose Next. 
 

In the Variables dialog box: 
 

• Browse for a HTML Report Template and Extract Variables. 
 

• Select Finish. 

• Create an Alignment (if necessary), using one of the previously learnt 
methods. 

• Turn off the Light Bulb for the Geometric Group 1 . 

This removes the Geometric Group 1 from the screen, making it a little less cluttered when 
taking the Surface Inspection.  Alternatively the Toggle Previous Measure Display Button 

 could be used, from the Full Screen Options Toolbar, in full screen mode later. 

• Create a Surface Inspection Group, by clicking on the Surface 

Inspection Group Button  on the Element Toolbar. 
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The Surface Inspection Group form 
opens up. 

 
Within this form the user can set the 
Name of the group and can decide on 
whether to take Surface Points, or 
Edge Points, Points on the Fly or 
Guided Points (see later).  They can 
choose the Minimum Number of 
Points they wish to take, as well as 
setting Counter Values, Labels and 
adding Comments. 

 
This form also allows the user to 
change the Local Offsets and 
Tolerances for this group, and 
whether or not it is output to the 
Report. 

 
In this example, a Surface inspection will be specified with points taken on the fly. 

 
• Keep all the Default Settings, making sure the Output in Report option is 
ticked, and choose OK. 

If the Delay Measure Button  is off, PowerINSPECT will automatically move to the 
Probing Screen, otherwise: 

• Right click over the Surface Inspection Group Icon  that has now 
appeared in the Sequence Tree and select Play. 

 
The user is now faced with new Probing Screen, and a minimum number of points (set in the 
Surface Inspection Group dialogue box – in this case 6) need to be taken to satisfy the 
inspection. 

 
As the points are probed the Surface Points on the 
Fly data box displays the deviation of the measured 
points.  These are displayed in all three axes, in 
terms of dX, dY and dZ as well as a resultant 
deviation dL. 

 
This box has similar options to that of the Feature 
Probing Dialogue Box seen in the previous chapter 
with addition of a Suspend Recording Button 

         , which allows the user to see the points 
without actually recording them as a result. 
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It also has a Parameters Button , which displays a dialogue box with a summary of the 
Measure Parameters used for Inspection Points and Guided Points (such as proximity 
criteria – which may need to be increased if points are not registering). 

 

 
 

• Probe any number of points on the Part 
Surface, making sure to satisfy at least the 
Minimum Number of Points set in the form. 

 

• When satisfied that enough points have 

been taken, choose OK.  

It can be seen that the Sequence Tree has now been 
updated, with the Surface Inspection Group icon 

having lost the Exclamation Mark.  The Surface Inspection results can now also be 
seen in the Report. 

 
• Select the  Tab to view the Surface Inspection Group Results. 

 
A display of all the elements chosen to be output to the report can now be seen.  This report 
can also be exported, and viewed through a Web Browser. 

 

• Choose the Export Report Button , and call it Report.mht.  Proceed 
to view this file with any installed Web Browser. 

 
 

As well as report formats, the results can be viewed from within the CAD View and the 
Sequence Tree. 
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• Open the Surface Inspection Group to view the points that have been 
taken.  Do this by either selecting Inspection Group 1 in the Sequence Tree 
and choosing the Open Group Button , or by choosing Open Group from 
the local Right-click menu. 

 
Note:  Just using the  Button, will open the group to display the points in the Sequence 
Tree, but the statistical data will NOT be displayed in the Print Preview. To view this, the 
individual groups need to be opened. 

 
Once open the points can be individually highlighted, deleted or modified (see Chapter 
Modifying Elements later). Double clicking on each point, will open its information list, 
detailing positions, deviations etc. 

 
By default, an open group is sorted by the number label of the points taken (SP-1, SP2, SP3, 
etc….). 

 
• Right-click anywhere inside the group and choose the Sort by Deviation 
option from the local menu. 

 
 

  
Sort By Number Sort By Deviation 

 
 

This sorts the points by the amount by which they deviate from zero, starting at the lowest 
and working up to the highest deviations.  See above for examples of both. 
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Data display in CAD view 
 

Geometric features and/or probed points can be displayed in all manner of 
formats 

 
 

‘Confetti’ displays the points as coloured spots. Green represents points within 
tolerance, Red for above tolerance and Blue for below tolerance. 

 

Confetti 

                                                                                                                       

‘In Place’ values  display the points as ‘pins’ with the length of each pin representing 
the amount of deviation. The pin colour also corresponds with the colours as described above 
(confetti). 

 
 
 
 
 
 
 
 
 
 
 

In Place Values 
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‘Labels’  can be activated to display boxed details of the Geometric features 
and/or results of probed points. Labels can be displayed alongside the ‘confetti’ or the ‘In 
Place’ formats. 

 
 

Selecting activates and displays all the labels in a horizontal format. 
 

Selecting activates and displays the labels in standard format (horizontal and vertical 
format) 

 

Label positioning can be customized by selecting . Individual labels can be moved by 
keeping the left mouse button down on a label whilst ‘dragging’.  

Selecting the Global Label Settings icon  allows the user to select the information that 
is displayed in the labels, including the label width. 
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Further filter display options are available by selecting  allowing the user to filter out the 
points displayed in the screen. By default, this is set to Display all. For example if the user 
only wanted to display the Out of tolerance points, they could choose the Only Out of 
Tolerance points option. The Custom option allows the user to set their own filter criteria. 
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Print Previews 
With the Surface Inspection performed, the user can print the data. 

 

• Select an ISO 2  view and choose the Print Preview Button . 

When the Print Preview Button  is 
selected, or the Print Preview option is 
chosen from the File Menu, then a preview 
of the CAD File, along with the Probed 
Points, is shown on the screen. 

 
If the user were to print the page, then this 
would be the output. 

 
If the Print Preview Button is selected 

whilst a Geometric group is opened , 
then a graph of deviation and coloured bar is 
included in the preview. 

 
Note: Ensure                                                   
is also selected from Tools-Options-Display 
Options. 

 
 
 

With Labels 

  
With In Place Values With Confetti and Colour Bar 
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4.2 Surface Inspection Group – Edge Points. 
 

PowerINSPECT allows the inspection of Edge points. 

• Create a New Document using the Wizard  and select 

 
• Browse for Demoblock2008.dgk. Open this file. 

• Create an Alignment (if necessary), using one of the previously learnt 
methods. 

• Select Surface Inspection Group . 
• Select the option Edge Points. 
• Keep all the Default Settings, making sure the Output in Report option is 
ticked, and choose OK. 

 

 
 
 

• Right click over the Surface Inspection Group Icon that has now 
appeared in the Sequence Tree and select Play. 
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The user is now faced with new Probing Screen, and a minimum number of points (set in the 
Surface Inspection Group dialogue box – in this case 6) need to be taken to satisfy the 
inspection. 

 
PowerINSPECT requires two probes points to define the edge that is required for inspection. 

 
 
 
 
 

• Probe a point on the surface whose 
edge is required to inspect 

 
 
 
 
 
 
 

PowerINSPECT displays a yellow mark to 
represent the point and a yellow triangle marker to 
indicate where the second point must be probed. 

 
 
 
 
 
 
 

The co-ordinates of the edge point that is 
required are now displayed in the left hand 
Probing screen. 
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• Probe the edge indicated by the marker 
to record the Edge point. 

 
Note: The point must be probed precisely. A 
progress bar at the bottom of the window indicates 
the proximity. The proximity criteria can also be 

changed by selecting  from the Probe window. 

 
Once the point is probed, the deviation is indicated in the 
right hand Probe Window. 

 
 
 
 
 

• Repeat the process above to take further edge points. 

• Once the probing is complete, select OK  
 
 
 
 
 
 
 
 

PowerINSPECT displays the edge points on the model 
as triangles. Display can be changed to suit (e.g. 
switching on labels). The colour of the triangles 
represents the deviation in the same way as ‘confetti’. 
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4.3 Surface Inspection Group – Guided Points. 
There are a number of ways to create a surface inspection from guided or targeted points. 
Guided points can be used to check the accuracy of a feature for which the CAD coordinates 
are known. 

Using the Dynamic Points Editor.  

The use of the Dynamic Points Editor Toolbar was also described in Chapter 3.2, as part of 
the Free Form Alignment. 

• Create a New Document using the Wizard  and select 

 
• Browse for Demoblock2008.dgk. Open this file. 

• Create an Alignment (if necessary), using one of the previously learnt 
methods. 

• Select the Dynamic Points Editor  from the Mouse Context Toolbar. 

The cursor has now changed to a Target Sight  in the CAD view.  This allows the user 
to select the points on the CAD surface that are going to be inspected as guided points. 
Points are created by simply ‘double left mouse selecting’ on the surface of choice. 

 
 
 
 
 
 
 

• Create a number of points on the 
Surface of the model. For example 
as shown. 

 
 
 
 
 
 
 
 

Points can be manipulated using the other Dynamic Points Editor Toolbar 
functions. See chapter 3.2. 

 
 

 

4.12 Issue PowerINSPECT 2010 Copyright © 2009 – Delcam plc 

. 



PowerINSPECT 4. Inspections 
 
 

 

• From the Dynamic Points Editor Toolbar, select Create a Guided 

Surface Inspection group.  
 
 

The points are placed into a Surface Inspection group in the sequence tree. 
 

 
 

• Select Play  button from the Main Toolbar. 

Once into the Full Screen Measure Mode, the Probing Process can occur. The Dynamic Point 

Targets  appear for the user to aim. 
 

 

A Green coloured bar at the bottom of the window indicates the proximity. 
 

 
 

Points will be accepted that are within the defined Proximity criteria.  
 

They appear in sequence order and as each one is probed the next one appears on the screen. 
• Probe all points in sequence order. 
• Check the Measurement results in the Report. 
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*Do not close the session* 
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Manually Entering Points 
 

• Ensure the Delay Measure Button  from the Main Toolbar is selected. 
• Create a Surface Inspection Group, by clicking on the Surface 

Inspection Group Button  on the Element Toolbar. 

 
 

• Select the option Surface Points 
and Create guided points (as shown). 

 
 

• Select OK. 
 
 
 
 
 
 
 
 
 
 

• Open  the new Surface Inspection Group. 

• The Element Toolbar now displays new options. 
 
 
 
 
 
 
 

• Select the first option Create Guided Surface Point.  
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This dialog allows the user to modify existing points (see page 4.13) or enter new 
coordinates to create points. 

 
• Enter the following co-ordinates in the Target Point area X 10, Y 15, Z 0. 
• Ensure the option Accurate coordinate is selected. 

 
The option Project point along direction can be used to project 
points (approximate values known) onto the surface in the 
direction defined. 

 
• Select Calculate Now then press OK 

 
The point is created on the surface. 

 

 
 

• Repeat the process above for the following coordinates. 

X 55  Y 80  Z 0 

X 60  Y 0 Z -10 (select direction ) 
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• Select Play  button from the Main Toolbar. 
• Probe all points in sequence order. 
• Check the Measurement results in the Report. 
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4.4 Introduction to Section Inspections 
Some users may wish to perform an inspection of a cross-section across a part. 
PowerINSPECT allows the user to create section lines, in any direction, along a surface. 
These sections can then be probed to inspect the deviation of that surface, in relation to the 
CAD data. 

 
Preparing a Session for Section Inspection 
For the purposes of this exercise, the section is going to be taken using the headlamp model 
as the CAD file. 

• Create a New Document using the Wizard  and select 

 
• Browse for Demoblock2008.dgk. Open this file. 

 
• Create an Alignment (if necessary), using one of the previously learnt 
methods. 

 
Note: If a session is already open, or has been saved and can be opened (with the part in the 
same position), then this can be used for the section inspection without the need to start a 
new session. 

 
 
 
 
 
 
 

At this stage, with the CMM aligned to 
the CAD data, the user would manipulate 
the view, in order to make a decision on 
where to take the section.  However, 
again for the purposes of this exercise, a 
section is going to be taken in the X 
plane (in the face of XZ) at a distance of 
X=200. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

4.18 Issue PowerINSPECT 2010 Copyright © 2009 – Delcam plc 

. 



PowerINSPECT 4. Inspections 
 
 

 

Generating a Section Inspection 
In order to inspect a Sectional area the user needs to define the section to be probed. 

 

• Select the Delay Measure Button . 

• From the Element Tool Bar choose the Section Group  Button. 

 
The Section dialogue box appears.  Within 
this the user can specify the Name, Line 
Colour, Cut Plane, Parameters, change 
the Display Options and the Item Naming 
Rules and add a Comment. 

 

Choosing the  Button allows 
the user to input a Rotation or Translation 
of the Section Line, as with the CAD File 
Parameter Edits. 

 
• Change the Cut Plane to the X- 
Plane, and enter a Coordinate 
Distance of 200 (as illustrated). 

 
• Leave all the other options as 
Default, and choose OK. 

 
 
 

By choosing 
OK, the CAD 
View is updated 
with a visible 
Section and a 
Section Group 
has appeared in 
the Sequence 
Tree (right). 

 
Note the initial 
Geometric PLP 
Alignment. 
When a Section Group is created a new tab appears at the base of 
the Graphics Window.  Selecting this tab opens the Section View.  
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The Section View (above) can be re-orientated using the arrow keys 
on the keyboard (for mirror moves) and the Page Up (anti-clockwise) 
and Page Down (clockwise) keys for 5-degree rotations. 

 
Using the Shift key in conjunction with the Page Up and Page Down 
will perform 90-degree rotations. 

 
 

With the part securely fixed to the CMM bed and aligned, the Section Group is now ready to 
be probed. 

 
 
 

• Orientate the View so that the section may be easily 
taken (e.g. from above down the Z-Axis). 

 
• Right Click over Section Group in the Sequence 
Tree to bring up the Local Menu (right). 

 
• Choose the Play option. 

Alternatively 
 

• Select the Section Group and choose Play from the 
Measures Menu. 

 
 

PowerINSPECT will then move to the Probing Screen. 
 
 
 

It is then up to the user to aim the probe along the section line and probe any number of 
points to measure that section.  This can be done easily if the user’s CMM has lockable axes, 
however if this is not available, then PowerINSPECT has some useful tools to help. 
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When in the Probing Screen, the Section 
Inspection Box appears, containing all the 
information about the inspection points. 

 
Across the top are the inspection icons, 
which perform the same functions as 
highlighted in the Free Form Alignment 
section. 

 

• Choose the Tracking Box Icon . 
The Tracking Box appears, allowing the user to see a numerical representation of the probe 
position.  Because the Part has already been aligned, the tracking can be set to the CAD 
Coordinates, to monitor the X=200 value. 

 
 

• From the Pull Down Menu, choose the 
CAD Co-ordinates option. 

 
From the Tracking Box the probe position can now be 
seen as close to X=200 as possible. 

 
 
 

However, to keep the probe at X=200 can prove very difficult if the axes cannot be locked, so 
the user needs to specify a wider range (around X=200) in which to obtain probed positions. 

 
• Choose the Measure Parameters 

Icon . 

• Select the Inspection Point 
Options tab at the top of the dialogue 
box. 

 
This dialogue box allows the user to increase  
or decrease the search parameters for 
inspection points for both Surfaces and Edges. 

 
Since this is a surface inspection, changes will 
only be made to the Surface Points. 

 
• Alter the Proximity Criteria, and the Maximum distance for guided 
points to the same value (in this example the value is 5). 
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PowerINSPECT will now allow points to be probed for the X=200 line at a minimum of 
X=195 and a maximum of X=205. 

 
Note:  This is just an example of a parameter 
change, and it is ultimately up to the user to 
decide on an acceptable search parameter 
for personal projects. 

 
• Probe along the X=200 line as 
accurately as possible. 

 
• When all the required probed 
points have been taken, choose the 

OK  Button. 

The section group has now been created. 
 
 

To the right it can be seen that the Sequence Tree  
has been updated, with the Cut Plane and Value now 
given for the Measured Section Group. 

 
If the Section Group is opened (see below left) the 
points are displayed in the tree each with their 
corresponding deviation. 

 

When opened, the Section Line can also be seen in the 
CAD View (below), with the probed confetti points along 
it. 
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• Select the Section Group tab to open the Section View. 

 
 

The Section View overleaf is shown with the Deviation as Vectors.  This can be change in 
the Section Group Tool Bar. 

 

 
Section View with Vectors Displayed 

 

The Section Group Tool Bar (right) allows the user to alter the display of the 

results.  The results can be displayed as Vectors  (above), Pins     

(below) or Linked Pins  (overleaf). 

Along with the Section View Toolbar, is a Mini View Toolbar, which contains a 

series of Zoom functions such as Resize to Fit , Zoom In  and Zoom 

Out . 
 
 

 

Section View with Pins Displayed 
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Section View with Linked Pins Displayed 
 

When the Print Preview Button  is selected, or the Print Preview option is chosen 
from the File Menu, then a preview of the Section View (or the CAD View of results), along 
with the Probed Points, is shown on the screen. 

 
If the user were to print the page, then this would be the output. 

 
Changing the display icon will alter the view.  In the example to the right the points are 
shown as Vectors. 

 
 

  
 

Section View Print Preview CAD View Print Preview 
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4.5 Geometric Feature Inspection (using Wireframe 
Checker.) 

 
The Wireframe Checker button  allows you to pick geometric features directly from a 
CAD model in the CAD view. The details of the feature you select are automatically included 
in the Inspect dialog for that feature. The Wireframe Checker works in conjunction with   
the Geometry Explorer Tab. 

 
 

The Wireframe Checker has the following picking modes: 
 

To change the picking mode, “Right-Click” in an empty space in the 
CAD view and select from the local menu 

 
 
 

Surface 
You can use the Surface-picking mode to highlight a whole CAD surface. If the surface is 
part of a complex 3D-wireframe entity, PowerINSPECT extracts the entity's details. 

 
 

Wireframe 
You can use the Wireframe mode to highlight a complex 2D-wireframe-entity piece of 
wireframe, such as a slot. PowerINSPECT extracts the arc at each end and the line on each 
side and displays their details in the Geometry Explorer. You can also use this mode to select 
arcs (circles). 

 
 

Simple Wireframe 
You can use the Simple Wireframe mode to highlight a single component of a complex 2D- 
wireframe entity, such as the arc at the end of a slot. You can also use this mode to select arcs 
(circles), lines and points. 

 
 

Point 
You can use the Point mode to pick a single point on the CAD wireframe. If you pick two 
points, PowerINSPECT constructs a line. If you pick three points, PowerINSPECT constructs 
an arc. 

 
 
 

. 
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When an item is selected from the CAD model, the Nominal data is displayed on the 

Geometry Explorer Tab. If the item is accepted,  then it creates a new item in the 
Inspection Sequence. 

 
 
 

Feature Inspection Example 

• Create a New Document using the Wizard  and select 

 
• Browse for Demoblock2008.dgk. Open this file. 

 
• Create an Alignment (if necessary), using one of the previously learnt 
methods. 

 

• Ensure the Delay Measure Button  from the Main Toolbar or 
Measures Menu is selected. 

• Ensure the Activate sequence items Button  from the Geometry 
Explorer Tab is selected. 

• Switch on the Wireframe Checker button  
 
 

Surface features / components will be selected from the CAD model. 
 
 

• Right-Click in an empty space in the CAD view and choose Surface from 
the local menu. 

 

 
 
 
 
 

• Select the central Cone feature on the CAD model and then select the 

green tick  in the Geometry Explorer to accept. 
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The feature has been added to the Sequence Tree within a new Geometric Group. 
 
 

 
 
 

• Select the Sphere feature on the CAD model and then select the green tick 

 in the Geometry Explorer to accept. 
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• Select the Cylinder feature on the CAD model and then select the green 

tick  in the Geometry Explorer to accept 
 

 

• Change the picking mode back to Wireframe. 
• Select the Slot feature on the opposite face to the cylinder. Change linked 

to - New Probed Plane before selecting . 
 
 

 
 
 

The sequence tree lists all items defined. 
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• Select Play All  

• Check the Measurement results in the Report. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Copyright © 2009 – Delcam plc Issue PowerINSPECT 2010 4.29 



4. Inspections PowerINSPECT 
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5. Measurements without CAD 
 
 
 

 

Introduction to Measuring Without CAD 
 

PowerINSPECT does not have to work with CAD Data. Physical Parts can be inspected 
for dimensional measurement and comparison without reference to a model.  Measurements 
are created using Geometric Elements, which are either probed, or referenced to probed 
elements. 

 
Preparing a Session for Measurement Inspection 

 
For the purposes of this exercise, no CAD data will be used. 

 

• Select Create a New Document.  
 

A new empty session has loaded 
 

The new session is now ready for inspection. 
 

Generating a Measurement Inspection 
 
 
 
 
 
 

A DemoBlock2008 (pictured right) will 
be used for measurement. The block 
should be aligned with the long facing 
(Delcam logo) towards the front of the 
CMM/Table 

 
 
 
 
 
 
 
 

Initially a datum will be created at the lower rear left corner of the block. This will allow 
measurements to be taken relative to this point and aligned to the axes of the datum. First 
a geometric group will be created and a PLP generated from the elements probed. 
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• Select the Delay Measure Button . 

• From the Elemental Toolbar, choose the Geometric Group  
Button. 

 
 
 

The Geometric Group dialogue box appears 
and prompts the user to name the group and 
add a comment if required. 

 
• Name the group  Datum Group 

 
• Untick Output in Report 

 
• Leave everything else as 

Default and choose OK. 
 
 
 
 
 
 
 
 
 
 

Now a series of Geometric Items need to be created for measurement from the Elemental 
Toolbar.  For this example six items will be created.  These include three Probed Planes 
defining the X, Y and Z planes, two Plane Intersection Lines for the X and Y axes and a 
Line Intersection Point for the Origin. 

 

• Select the Planes Button , and choose the Probed Plane  
• Use OK & Repeat to create three planes. 

 
Plane 1 will be Probed from the CMM bed and will define the Z 0 plane 
Plane 2 will be Probed from the left hand face of the block defining the Y 0 plane 
Plane 3 will be Probed from the front face of the block defining the X 0 plane 

 
• Create a Line called XLine using the Line: Two Planes Intersection 

Icon from the lines menu  filling in the form as shown below; 
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The new line is to be generated from the intersection of the CMM table, Plane 1 and the front 
face of the block, Plane 2. This line will be used to define the X axis in the PLP later. 

 

 
 

• Complete the form as shown and press OK & Repeat 

• Repeat the process to create a second line called Yline defined by the 
intersection of Plane 1 & Plane 3 
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Finally a point will be created at the intersection of Xline & Yline. 
 

• Select the Point from Lines Intersection Icon  from the lines menu 
and fill in the form as below, then press OK 

 

 
 
 

• Complete the form as shown and press OK. 
 

This point will be used as the XYZ origin in the PLP. 
 
 
 

• Once the Geometric Elements have been defined select Play All     
and probe the three planes in the order described above (CMM table, 
Front Face, Left Face). 

 
The Lines and Point will be generated automatically from the Probed Planes. 
With the Geometric Elements now defined and measured we can create the PLP alignment. 

 

• Move up the levels  until Geometric Group 1 is Closed. 

• From the Alignments Sub-Menu icon , in the Element Toolbar: 
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• Choose the Geometric PLP Alignment button . 

• Fill in the form as shown below and press OK. 
 

 

The CAD co-ordinate system has now been aligned to the demoblock2008 part. The 
generated lines and point can be seen in the CAD view. This will now allow measurements to 
be made relative to the X, Y and Z axes to the block. 
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• Create a new Geometric Group  filling in the form as follows; 
 

 

 
Please note that although the measurements will be output in the report there will be no 
CAD nominals to report against. If a drawing is available the nominals can be set by 
modifying each Geometrical Element to be probed. 

 
The first dimension to be measured is the height of the block. In this case a Probed Parallel 
Plane will be used. This will measure the height of the block. 

 

• Select the Planes Button  again and choose the Probed Parallel 

Plane  (using Plane 1 as the Reference Plane) 

• Fill the form in as shown 
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• Press OK and then Play  the item. 

• Probe the horizontal top face of the block. 
 
 

 
 

The Feature Probing form shows the Distance between the CMM surface and the top of the 
block (44.928mm), the Flatness of the top surface (0.3099mm) and the maximum deviation 
of points measured from the best fit plane (-0.1561mm). It should be noted that the latter two 
items are not output to the report. 
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In the sequence tree it can be seen that the height of the plane has been updated 

 

 
 

We will now measure the sizes and relative positions of the two holes towards the front of the 
block. 

 
 

• Open  the Measurements No CAD group, if not already inside. 

• Select the Features Button , and choose the Probed Circle , 
(referencing it to the top Plane 4). 

 

 
 

• Press OK and Repeat to create a second Probed Circle 
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• Play both items and measure the circular holes in the block using the 
techniques previously learned 

 

 
 
 

• Select the Dimensions Button , and choose the Relative 

Position Button . 
• Fill in the form as below and press OK 
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From the sequence tree the relative positions between the two circle centres can be seen 
referenced to the X & Y axes of the PLP. 

 

 
 
 

Finally we will measure the overall length of the block in the X and Y directions. The 
distances will be measured using the Origin Point created at the beginning of this section plus 
two new Probed Lines 

 

• Select the Probed Line   Icon and create 2 probed lines. 

Ensure Plane 1 is selected as the reference plane (Table) 
 
 

 
 
 

• Play the lines, measure the first on the Right of the block and the 
second on the Back (parallel to plane 2). 

• Now select the Dimensions Button , and choose the Line Point 

Distance Icon  
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• Fill in the form as shown 
 

Line 1 is on the Right hand Face of the block, Origin is at the PLP datum origin. The distance 
between them gives the overall length of the block in X. This is shown in the updated 
Sequence Tree below. 

 
 
 

• Repeat by selecting the Dimensions Button , and choose the 

Line Point Distance Icon  

• Fill in the form as shown below; 
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Line 2 is on the back Face of the block, Origin is at the PLP datum origin. The distance 
between them gives the overall width of the block in Y. This is shown in the updated 
Sequence Tree below 

 
 

Probing 3D Features 
 

3D features will be added to the inspection. 
 

• From the Elemental Toolbar, create a second Geometric Group . 

• From the Features Button , select Probed Sphere , Probed 

Cone  and Probed Cylinder . (keeping the default settings) 

The sequence tree lists the defined features. 
 

 

• Select Play All  and probe the three features in the order defined. 
 
 

 
 

The CAD view is updated to show the new probed features 
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• Inside Geometric Group 1, Select Circle: Cone Cylinder intersection 

 from the Features Button . 
 
 

 
 

• Select the Cone and cylinder as reference features, and select OK. 

Circle 3 is generated at the intersection of the Cone and Cylinder. 
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The Report shows the details of this inspection. Nominal dimensions need to be added to 
provide Error/Deviation results. These can be added at this stage by using the Modify Item 
Icon in the Sequence Tree to open each Geometric Element in turn and change the nominal 
value. 

 

 
 

There are many other ways in which it is possible to measure dimensions from a Physical 
Part, the aim of this example is to give an introduction to the basics of measuring without 
CAD data. For details of alternative methods please ask your tutor. 

 
 
 

Points can also be taken on the component without the need of a CAD model.  This can be 
useful for example, for reverse engineering applications. Point Cloud and Points on the Fly 
are two methods outlined below. The points taken will be included into the current 
Inspection Sequence. 

 
 
 
 

 

5.14 Issue PowerINSPECT 2010 Copyright © 2009 – Delcam plc 



PowerINSPECT 5. Measurements Without CAD 
 
 

 

Point Cloud Group  
 

Point cloud (3D digitised data) can be obtained in two ways. 
 

1. Contact – Using devices such as touch probes attached to Portable Arms or CMM 
machines. At point of contact, the X, Y and Z coordinates are taken. 

2. Non-contact – Using devices such as line or scanning point lasers. 

Point cloud data will be included in this inspection sequence. 

 
• Create Point Cloud Group, by clicking on the Point Cloud Group Button 

 on the Element Toolbar. 

 
• Keep all the Default Settings, and 
choose OK. 

 
 
 
 
 

The Element Toolbar is now replaced with the Point Cloud Group Toolbar. 
 
 

Button Description 
 

 
 
 

Create a point cloud by probing points on the fly. Allows you 
to probe points on the part and PowerINSPECT saves them as a 
point cloud. You can project this point cloud to the CAD model  
to view the deviation between them.This button allows you to 
delete all the points already probed in order to re-probe them. 

 

 
 

Sketch a digitised curve. Allows you to probe points on the  
part and fit a curve through them. The curve is saved in the point 
cloud group and can be exported for use in CAD applications. 

 

 
 
 

Import a cloud of points from a file. Allows you to import 
points that have been probed using a different application. The 
cloud of points is imported as a single element in the point cloud 
group and can then be 'projected' to find the deviation between 
the probed points and your CAD data. 
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• Select Insert a Point Cloud  to probe points on the fly. 

 
The Point Cloud Tool Window appears ready to 
take points. 

 
 
 
 
 
 
 
 
 
 
 
 

• Scan/Take points on the surface profile 
(as shown in blue) using the appropriate 
method for the probe type. 

 
 
 
 

Once taken and accepted , the points are displayed in 
the CAD view (using ball probe) 

 
 
 
 
 
 

• Still within Point Cloud Group 1, select the Curve option.  
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• Sketch 3 curves by taking points across the 
curved edge radius (as shown in blue). 

 
 
 
 
 
 
 
 

Once taken and accepted,  the three curves are 
displayed in the CAD view. 

 
 
 
 
 

The Point Cloud Group 1 in the sequence tree is updated.  

Single Points on the fly  
 

Single points can also be taken as geometric elements anywhere on the part. Single points on 
the fly are the same as guided single points except the nominal value does not have to be 
entered (to which you are guided to take a point). 

 
 

• From the Element Toolbar, create a new Geometric Group . 

• Select Single Points on the Fly.  
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The compensation drop down menu can control whether probe compensation is required on 
the points taken. 

 
 
 
 
 
 
 

• Probe a number the sloping surface on 
the block (as shown in blue). 

 
 
 
 
 

Once taken and accepted , the points are 
displayed in the CAD view (using ball probe) 

 
 
 
 
 
 
 

The CAD view shows all the Geometric 
features and points that have been 
taken. 

 
 

These will now be exported from 
PowerINSPECT. 
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File Export - IGES 
 

Geometric entities and surface points can be exported from PowerINSPECT to an IGES file. 
This therefore allows the transfer of PowerINSPECT data to CAD/CAM packages, e.g. for 
reverse engineering applications. 

 
• From the File menu select Export – IGES. 

 

 

 
You can export the elements in a NURBS format. NURBS surfaces are the preferred format 
for many CAD systems, including PowerINSPECT. If you don't select the NURBS option, 
the 3D elements are saved in a Surface of Revolution format and planes are saved as Rule 
Surfaces 
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• Define a path to export the file and then select OK to save. 
 

The data can be imported into a CAD system and manipulated as required. 
 
 

The example below shows the data imported into Delcam PowerSHAPE where the probed 
planes and features are now represented as NURB surfaces. 
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6. Inspection program 
 
 
 

 

Inspection Program Example. 
 

The following working example creates a simple Inspection program. The program includes 
various features shown in previous chapters, including a PLP alignment, Geometric Feature 
measurement, Surface, Dynamic points and Section Inspection. 

 
 

For this example, the DemoBlock2008.dgk model will be used. 
 

Using the methods, previously described in the course, for starting a new session: 
 

• Create a New Session and Browse for DemoBlock2008.dgk. Open this 
file. 

 
• Keep the Default Settings for Offsets and Tolerances, and choose Next 

 
In the Variables dialog box: 

 
• Browse for any chosen HTML Report Template (Excel could be used, 
but for this example HTML is to be used), and Extract Variables. 

 
• Select Finish. 

 

• Shade the view  and then re-orientate it to a Z view from top.  
 

The new session is now ready for programming. 
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Geometric PLP Alignment 
 

• From the Mouse context toolbar select Wireframe Checker  

• Select the wireframe of the hole Circle 1 (as shown below). 
 

• Make sure that the linked to option is set to New Probed Plane. This 
associates the circle with the new probed plane. 

 
• Press the Green tick  button to accept the selected feature. 

• Repeat the above process to select hole Circle 2. 
 

• Select Plane 1 from the linked to option. 
 

• Press the Green tick  button to accept the selected feature. 
 
 
 
 

 
 

Circle 1  
Circle 2 

 
 
 

To satisfy PLP criteria, a Line is to be created between the Centres of the Two Circles, and 
therefore the Line Between Two Points option is required for the item. 

 

• Select the Lines Button , and choose the Line: Two Points . 
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• Set Reference Point 1 as 
Circle 1: Centre, and Reference 
Point 2 as Circle 2: Centre. 

 
• Use the Nominal Loading 
drop-down button to 
load the line values 
from the CAD 
Entity. 

 
 

• Tick  to display 
the nominals in the report. 

 
• Leave the other settings as 
Default. 

 
• Choose OK. 

 
 

The Line has now been created and the Sequence 
Tree has been updated to include all the 
Geometric Items (left). 

 

• Close the Geometric group by selecting Up One Level . 

• From the Alignments Sub-Menu icon , in the Element Toolbar: 

• Choose the Geometric PLP Alignment button . 

• Select the Circle 1: Centre as the point element, and use the Load 
Nominals button  to load the CAD Nominals for all three items. 

 
• Select OK. 
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Geometric Feature Inspection 
 

2D/3D Geometric Features will now be selected to begin the Inspection Sequence. 
 

• From the Element Toolbar select the Geometric Group button , and 
accept the Defaults. 

 
In this group, the Slot and Cone will be measured. 

• Ensure the Wireframe Checker button  is switched on. 

Because the cone is a surface, the Geometry Explorer needs to be set up to look for Surface 
Components. 

 
 

• Right-Click in an empty space in the CAD view and 
choose Surface from the local menu. 

 
 
 

• Select the Cone in the centre of the model, and choose the green tick      
to accept the feature. 
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Because the slot is a Wireframe item, the Wireframe Checker needs to be returned to the 
Wireframe state. 

 
• Right-Click in an empty space in the CAD view and choose Wireframe 
from the local menu. 

 
• Select the Rounded slot on the side of the block. 

 

 
 
 

• Ensure the linked to option is set to New probed plane, before selecting 

the green tick.  

• Close the Geometric group by selecting Up One Level.  
 
 

Bouncing Ball 
 

“Bouncing ball” is an on-screen guide which aids the user as to what has already been 
measured and what is to be measured next. Points are displayed as spheres in different 
colours to guide the user during the inspection. During inspection, the following default 
colours will be displayed: 

 
Blue sphere: Initial colour of unmeasured points. 
Red sphere: Next point to be measured. 
Grey sphere: After point has been taken 
Transparent Red: Actual position of point taken/probed. 

 
To illustrate this functionality, the Bouncing ball will be applied to the two Geometric 
Features defined above. 

 
• Open Geometric Group 2 in the sequence tree to show both geometric 
features. 
• At the Geometry Explorer, select the features tab. 
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The CNC mode option is currently switched off . In order to use Bouncing Ball, this 
option needs to be activated. 

 

• Toggle the icon to switch CNC mode ON.  
• Highlight Cone 1 in the sequence tree, which will update the features tab. 

 

 
 

• Select the recycle button  to edit the options. 
• From the Probe path strategy drop down list, select Manual and then 
Sliced points. 
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The cone now shows red spheres as the probe points and green lines/arcs as the shortest 
distance between the points. 

 

 
 

• Select  to accept and save the geometric feature. 
• Highlight Slot 1 in the sequence tree, which will update the features tab. 

 

 
 

• Repeat the above procedure for the Slot feature but also change Probe 

externally  to Probe internally . 
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• Select to accept and save the geometric feature. 

• Select to close the dialogue and then select the Geometry explorer 
tab. 

 
The bouncing ball feature is now applied to the two geometric features. This will be activated 
in the sequence tree during “play” mode. 

 

• Switch OFF CNC mode  
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Surface Inspection 
 

The next stage is to perform a random Surface inspection. 

• Create a Surface Inspection Group, by clicking on the Surface 

Inspection button  on the Element Toolbar. 
 
 

 
 
 
 
 

The form shows a random (Take points on fly) Surface Inspection with a minimum 
number of points to probe as 6. 

 
• Leave all settings as Default. 
• Choose OK. 

 
This inspection group has been added to the Sequence tree. 

 
 
 
 
 
 
 
 
 
 
 

 

Copyright © 2009 – Delcam plc Issue PowerINSPECT 2010 6.9 



6. Inspection Program PowerINSPECT 
 
 

 

Guided Surface Inspection 
 

This will create another surface inspection but instead using Guided Points, The Dynamic 
Points Editor will be used to specify the specific points to be probed. This was discussed in 
Chapter 6. 

 

• Select the Dynamics Points Editor  from the Mouse Context 
toolbar. 

 

• Double-click on the model surface approximately in the areas shown 
below, to specify the three Dynamic Points. 
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• Select Create a Surface Guided Inspection Group  from the right 
hand menu bar. 

 
In the sequence tree, an Inspection Group has now been created including the three dynamic 
points. 

 
 

• Close this Surface Inspection group by selecting Up One Level . 

• Switch off the Dynamic Points Editor by selecting  again. 

Finally, a Section Inspection will be included in the program. 
 
 

Section Group Inspection 
 

The same method will be used as described in Chapter 8. 
 

• Orientate the model to a Z view from top.  

• From the Element Tool Bar choose the Section Group  Button. 

• Modify the form to create a section on X=70 
 

• Leave all the other options as Default, and choose OK. 

The Program is now complete with the sequence tree outlining all the items that have been 
created. 
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Two extra features (inspection aids) will be added to the inspection sequence to assist the 
inspectior. 

 
 

CAD View State 
 

CAD View State  allows the user to save a current view (orientation and zoom) of a 
CAD view and add it to the Inspection Sequence. 

 
During the inspection, the CAD view will load automatically allowing the inspector to 
continue probing. Not having to pause and manipulate the CAD model manually, speeds up 
the whole inspection process. 

 
A CAD View State will be added to the Sequence Tree to illustrate this functionality. 

 
 

• Zoom and Orientate to a suitable view around the slot feature and select 

CAD View State  on the Element Toolbar. 
 
 

 
This CAD View State has been added to the bottom of the Sequence. 
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• Expand Geometric Group 2 by clicking the + symbol adjacent to the 
name, to show the two geometric features. 

 
 

 
 
 
 

• Select the new CAD View State. Keeping the left mouse button down, 
“drag and drop” the CAD view on top of the Cone 1 feature. 

 

 
 
 
 

The view is now placed just before the Slot feature, displaying the view just prior to the 
inspector probing the feature. 

 
 

Comment 
 

Another feature to assist the operator during inspection is by including a Comment box into 
the Inspection Sequence. 

 
As with CAD View State, the item is placed into the sequence where the comments / 
information needs to be displayed. 

 

• Select Comment  from the Element Toolbar. 

This launches a dialogue box where instructions including images and videos, can be added. 
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• Enter the following text. 

“Probe 10 points in and around the sphere feature”. 
 
 

• Press the Green tick  button to accept. 

 
The stored comment is added to the bottom of the sequence. 

 
• Drag and Drop the new Comment box on top of Geometric Group 2. The 
comment will now display just prior to the Surface Inspection 

 
 

The program is now complete and ready for inspection. 
 
 

• Select Play All  from the Main Toolbar, or Measures Menu. 

The screen changes to the Play Mode view indicating what needs to be measured and the 
minimum number of points required. 

 
• Measure all the requested points. 

 
• Check the Measurement results in the Report. 
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CAD view report 
 

In addition to CAD view state, PowerInspect also allows a CAD images to be 

included in the final report. This feature is called CAD view report  and is 
also accessed from the Element Toolbar. 

 
 

• Return to the CAD view. 

• Apply labels  as preferred. 
• Orientate the model to a suitable view. 

• Select CAD view report  from the Element Toolbar. 
 

 

The form allows the user to change the Orientation, Alignment and Size of the 
image in the report. 

 
• Select OK. 
• View the final results and image in the Report. 

• Export  the report. 

• Save the File  in any chosen location (e.g. C:\Temp). 
• Name the file Inspection program.pwi 
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7. Modifying Elements 
 
 
 

 

Introduction to Modifying Elements 
Many elements created within PowerINSPECT can be modified one way or another. 
Modifications can be made to elemental items, probed points and even PowerINSPECT 
itself (display options etc.). 

 
This chapter briefly goes through the deletion and reordering of points, and some display 
modifications. 

 
Accessing Modification 
Editing or modifying items can be accessed in three ways. 

 
The first is to choose (with the item selected) Modify from 
the Local Right-Click Menu (see right). 

 
The second simply involves (again with the item selected) 

clicking on the Modify Button  in the Sequence Tree 
Toolbar (see below – and located at the top of the Sequence 
Tree), and the third is to use the short-cut key combination of 
Alt+Enter. 

 
 

 
 
 

For pre-created Geometric Items, Modification brings up 
the dialogue box that specified the item’s parameters. This 
allows the user to change the constraints that set the item. 

 
For example in the Geometric PLP Alignment where a Line 
was specified using the Centres of Two Circles, it may be 
altered to pass through different elements. 

 

In the same way, the Alignment itself could be modified, by bringing up the alignment box 
that created it to change the Plane, Line and Point that defined it. 

 
Most modifications work on similar principles, but these might affect the results.  The next 
example runs though the deletion of an unwanted result, and demonstrates how to rectify the 
point numbers in order to maintain a continuous set of results. 
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Anomalous Result Example 

 
It is possible that when probing a point, an error can be made (e.g. probing too hard, taking 
too many points, points in the wrong place, false triggering etc.) that creates an unwanted or 
anomalous result.  These results can affect, for example, a line of best fit or an inspection 
report, so it is often best practice to delete them. 

 
In this example the DemoBlock2008 part was probed and during its Inspection an 
anomalous result was taken.  This anomaly was verified, by taking a point at the same 
position, and comparing the results.  As can be seen from the Sequence Tree, the deviation 
of the anomaly is much greater than that of the surrounding results, hence this should be 
removed from the group. 

 
Note:  The Inspection Group is Open (below left) so as to see the points. 

                                               Anomalous Result SP11 

Assuming an anomalous result exists: 
 

• Open the affected Group . 

• Right-click on the Anomalous result (in 
this case SP11) and choose the delete 
option from the local menu (see right). 

 
The point will then be removed from the screen, and 
the Inspection Group. 
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However this leaves a gap in the point numbers, which 
need to be reordered (left). 

 
 

• Move Up One Level  in the Sequence 
Tree. 

 
 

The numbering of the Surface Inspection Group can 
now be modified. 

 
 
 
 
 
 
 
 

• Highlight Inspection Group 1 and 

choose the Modify Button . 

 
Choosing modify brings up the Surface 
Inspection Group dialogue box and allows the 
user to reset the creation parameters. 

 
To reset the numbers for an inspection the 
following changes need to be made in the Item 
Naming Rules Area: 

 
 
 

• Enter a Counter Value of 1. 
 

• Enter an Incr. (Increment) Value of 1. 
 

• Tick the box marked Update existing points now. 
 

• Choose OK. 
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The Points will then be updated in the Sequence Tree 
(see right). 

 
Note that point numbers SP11 and SP12 have been 
updated to become SP10 and SP11 respectively. 

 
 
 
 
 
 
 
 
 

Replaying Probed Items. 
 

Individual Features and Points can be replayed. For example, if a confirmation is required. 
 
 

• Right-click on SP10 and choose the Reset Item option 
from the local menu (see right). 

 
• The point will be reset and indicated in the sequence 

tree as  

Note: Selecting Reset All will reset all the measures in the Group. 
 

• Select the point and then Play Element  

The point will indicated as a dynamic point in the CAD view  

• Probe the point. 
 

The sequence Tree and report will be updated with the new measure. 
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8. Multiple Alignments 
 
 
 

 

Introduction to Multiple Alignments 
 

PowerINSPECT allows the ability to use Multiple Alignments in a single PowerINSPECT 
session. 

 
Multiple Alignments can be used in a variety of situations. 

 
 

• To define a local coordinate system or datum to help in the measurement of features, 
especially on large and flexible components. 

• Provides flexibility to inspect large and flexible components in assembled condition 
more accurately. 

• PowerINSPECT allows you to choose an alignment (that has been created) for each 
item in the inspection sequence 

• If the original location of the component is changed, it now can be realigned without 
losing the previously measured results. 

• Customer requirements can dictate that multiple alignments are used. 
 
 

Multiple Alignment Example 
 

The following Inspection session outlines how alignments can be used in combination. For 
this example, the DemoBlock2008 file is going to be used 

 
 

• As described in Chapter 3.1, Create a PLP alignment using the two holes 
as before. 

 
 
 
 
 
 
 
 
Circle 1 

 
 
 
 
 
 
 
 
Circle 2 

The Two Circles chosen are 
indicated (left), and the Plane 
will be the top face.  The Line 
will be between the Centres of 
Both Circles, and the Point 
will be taken from the Centre 
of Circle 1. 
Both circles and line will 
therefore be projected onto the 
base (plane) 
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The Alignment is shown once created. 
 

 
 

A Surface Inspection will now be created, as described in chapter 4.1. 
 
 

• Create a Surface Inspection Group, by clicking on the Surface Inspection 

Group Button  on the Element Toolbar. 

• Take Surface Points on the Fly across the model as shown below. 
 
 
 
 
 

The results show that the 
surface used for the PLP 
alignment itself (plane 1) is 
within tolerance. 

 
 
 
 
 

However, the 3D surface on 
the right hand side of the 
block is correct in the centre 
but out of tolerance towards 
the edge of the block. 

 
 
 
 
 
 
 

 

8.2 Issue PowerINSPECT 2010 Copyright © 2009 – Delcam plc 



PowerINSPECT 8. Multiple Alignments 
 
 

 

A second alignment will now be created to check the 3D surface to itself (rather than the first 
alignment (PLP) which was on a different surface). 

 
However, due to the free form nature of this surface, the most appropriate alignment would 
be the Free Form method. 

 
 

• As described in Chapter 3.2, create a Free Form alignment using 
dynamic points positioned on the surface as shown below. 

 
 
 
 

 
 
 

• Create a new Surface Inspection Group, by clicking on the Surface 

Inspection Group Button  on the Element Toolbar. 

• As before, take Surface Points on the Fly across the model as shown 
below 
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The results show that the 3D 
surface used for the Free 
Form alignment itself is now 
within tolerance. 

 
 
 
 
 
 
 
 
 
 

But the original PLP surface (Plane 1) on the left hand side of the block is correct in the 
centre but now out of tolerance towards the edge of the block. 

 
The two sets of results indicate a strong possibility of some deformation around the centre of 
the component. 

 
The active alignment and associated Geometric groups can be changed by selecting it from 
the main menu. 

 

 
 
 
 

Transforming Data 
 

Multiple Alignments can also be utilised to measure components that are too large for the 
CMM limits. A new alignment and measurements can be taken after the component is moved 
to its new position. The original data (e.g. Alignment and Surface points) can then be 
transformed to the new alignment position. 

 
If a portable arm is used, the device can be moved to a new location. A new alignment and 
measurements can then be taken.  However the Repositioning Wizard in PowerINSPECT, 
also allows simple device Repositioning. This technique will be shown later. 
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To illustrate Data transformation, a new third alignment will be added to this Inspection 
session. 

 
As the component is not large enough, it will be moved to a new location to simulate the 
effect. 

 
• Move the component to a new location (but still within range of the 
device). 

 
 

• As described in Chapter 3.4, a Best Fit From Points alignment will be 
created as the third alignment using the features shown below. 

 
 

 
 
 

• Select the features and then Play  
 
 
 
 
 
 
 
 
 

The features are displayed prior to 
alignment. 
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• Create a Best Fit from Points alignment using Point 1 and Circle 3, 4 
centre points. 

 
• Ensure the new Alignment is selected as the  
active alignment from the main toolbar. 

 

 
 

• Create a new Surface Inspection Group, by clicking on the Surface 

Inspection Group Button  on the Element Toolbar. 

• As before, take Surface Points on the Fly across the model as shown 
below 
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Selecting the other alignments display them in the previous position. 
 
 

 
 
 

These previous two alignments will now be transformed to the current active alignment. 
This will then provide us the ability to cross reference the measured geometry and surface 
inspections in all alignments. All alignments will also sit on the CAD once transformed. 

 
The sequence tree should be as follows. 

 

 
 

• Select Geometric Group 1 and then modify  (or right mouse button 
select). 

 
 

• Select Geometric PLP Alignment 1 from the 
Default coordinate system. 

 
 
 

• Ensure the option Update coordinate 
system of existing entities is ticked, before 
selecting OK. 

 

 
 
 
 

 

Copyright © 2009 – Delcam plc Issue PowerINSPECT 2010 8.7 



8. Multiple Alignments PowerINSPECT 

This transforms the coordinate system of the Geometric Group 1 and its contents (PLP) to 
the current active alignment (Best Fit from Points). 

 
 

  
 
 

  

 
• Select the Report tab 

 
 
 

The Geometric Group 1 
features now refer to the 
transformed Alignment 
(PLP) 

 
 
 
 
 
 
 

However the alignment 
itself and surface 
inspection data also 
require transformation. 
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• Select Geometric PLP Alignment 1 and then modify  (or right mouse 
button select). 

 
• Tick the option Use Transformed Data, before 
selecting OK. 

 

• Select Inspection Group 1 and then modify  (or right mouse button 
select). 

 
 

• Select Geometric PLP Alignment 1 from 
the Default coordinate system. 

 
 
 

• Ensure the option Update coordinate system 
of existing entities is ticked, before selecting 
OK. 

 
 
 
 

The report is now 
updated correctly. 

 
 
 
 
 
 
 
 
 

• Repeat the above process for all the items in the sequence tree (Including 
Best Fit) ensuring all data used to create an alignment is transformed into that 
alignment. 
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Sample sections taken from final report. 
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9. Device Repositioning 
 
 
 

 
 

The repositioning wizard in PowerINSPECT provides the ability to move the part and/or 
measuring device without losing the alignment. This allows the user to inspect a part that is 
larger than the device’s measuring envelope. 

 
The wizard works by creating a new repositioning datum by specifying at least three 
elements. These elements can be a combination of spheres and single points. The part or 
device can then be relocated and the same elements measured again. PowerINSPECT 
matches the two positions and so can relate the new measurements to the original alignment. 

This allows the user to carry on inspecting the part using the same co-ordinate system. 
 

After creating a position, it can be edited and deleted from the session. The position can also 
be reactivated if you are certain that inspection device is in the exact same position. 

 
 

• Create a New Document using the Wizard  and select 

 
• Browse for Demoblock2008.dgk. Open this file. 

• Create and confirm the Alignment using one of the previously learnt 
methods in Chapter 3. 
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• From the Machine Toolbar , select Repositioning Wizard . 
 
 

 
 

• Ensure the first option (Create New position) is selected and then click 
Next. 
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The elements are selected at this stage (at least three). 

 is selected to create a sphere element. 

 is selected to create a single point element (note: hard probe should only be used) 

 
For this example, three single point elements will be selected on the demoblock2008 part, 
as shown. 

 
 

 
 
 
 
 
 

• Select three times to select three single point elements. 
 

 
 

• Select Next. 
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The three elements now require measurement 
 

 
 
 

• Measure the three point items as indicated above. 
 
 

 
 

The measured coordinated for the three points are displayed. 
 

• Select Next. 
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The wizard now instructs the user to move the inspection device to a new location. 
 

• Move the inspection device (or to simulate the same effect, move the 
component block to a new location). 
• Select Next. 

 
 

 
 

• Measure the same three points in the same order as initially taken and 
select Next. 
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The deviation from the transformation is shown. Calculate Deviation can be used to calculate 
the deviation from selected items. 

 
• Select Finish, to complete the Device Reposition Wizard. 

 
 

 
 

Note: 
The new position is saved and called Position 1 (in this case). 

 
Previously saved positions can be Reactivated and Edited, from the opening page of the 
Wizard. 
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10. Machine Tab (Manual CMM) 
 
 
 

 

Introduction to Machine Tab 
 

The Machine Tab is used to manage the measuring device when PowerINSPECT is 
connected to a CMM. Please note that no information is displayed in the tab if 
PowerINSPECT is connected to an arm. 

 
The Machine Tab is available from the document window to enable the user to manage the 
probe heads, probes and calibrations in one place. 
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The Probe view 
 

The probe view lists the details of the measuring device and probing tools for the document 
 
 

 
 
 

The active probe head, probe, and probe position are shown in bold. The view also indicates 
the calibration status by displaying a calibrated tick  or uncalibrated cross  for each 
entry in the list. The following options are available: 

 
 
 
 
 

Change active probe or probe position. 
 

Edit the selected probe tool assembly. 
 

Define a new probe position. 
 

Delete the selected item in the tree. 
 

Delete all uncalibrated probe positions in the tree. 
 

Delete all probe positions in the tree. 
 

Calibrate the selected item. 
 

Calibrate all uncalibrated probe positions in the document. 
 

Calibrate all probe positions in the document. 
 
 
 
 

The following exercises will demonstrate the creation of a new probe assembly and 
calibration. 

 
It should ne noted that the exact procedure will vary from CMM to CMM. You should follow 
the prompts given on your machine. Ask your tutor if in doubt. 
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Creating a new probe assembly 
 

For the purposes of this exercise, no CAD data will be used. 
 

• Select Create a New Document.  
 

A new empty session has loaded 
 

• Select the Toggle Machine Toolbar   from the Main Toolbar. 
 

 

• Select the Connection Button  

 
A window is displayed during the 
connection attempt to the machine. 

 
 
 

If successful,  is displayed in the Machine Toolbar (replacing the Not 
Connected). 

 
 
 

• If the user is prompted to move 
the probe head, Select OK 

 
 
 
 

The Machine Toolbar now displays the Not                                                                   Homed message. 
 

• Select Home  

• Move the CMM to the positive 
end stops (machines do vary) and 
then trigger the probe as 
requested. 
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The following assembly will be created as an example. Where applicable, substitute the 
components to match your own hardware. 

 
Expand the Probe Head Tab (if not already open) by selected the down 
arrow . 

• From the drop down list, select the head MH20i. 
 

 

Note: From this tab, a new head can be created by selecting  

• Select Create to display the form. 
 
 

Head type can be changed here (e.g. Fixed, Manual 
Indexable) 

 
 
 
 
 
 
 
 

• Select Cancel as the previously 
selected MH20i will be used in this 
example. 
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Expand the Probe Tool Tab  

 
 

 
 
 

• Select . 

• At the top of the Tab, Enter a suitable name for this assembly (e.g. New 
Assembly) 

 

 
 
 

At the bottom the Tab, a list of modules are displayed. 
 

 
 
 

• Highlight the  module. 

• Select  
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• Highlight the  styli. 

• Select  
 
 

 
 

The final component to be selected is an extension. 
 
 

• In this example, no extension will be used, therefore select. 
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This message allows the user to ensure the 
actual assembly/components are assembled. 

 
 
 
 

• Ensure assembly is fitted, and then press OK. 

The probe and probe tool that has just been defined will be kept in this .pwi file when saved. 
Therefore, this procedure does not need to be repeated for each new .pwi session. 

 
 

There are three options at the bottom of the Machine Tab. 
 

 
 
 

These settings can be imported or exported (saved) to be used in other .pwi files. Therefore, 
this procedure does not need to be repeated for each new .pwi session. 

 
You can also choose to export these settings to a definition .pdb file, which can then be 
imported into other .pwi files. In this way, you do not need to set up the same settings for 
each .pwi file. 

To specify the default settings, click Export as default on the Machine tab. This saves your 
settings to a default.pdb file, which is automatically loaded each time you create a new 
inspection session. 

 
 

The New Assembly is now displayed at the top of the Machine Tab, summarising the tool 
setup. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

Copyright © 2009 – Delcam plc Issue PowerINSPECT 2010 10.7 



10. Machine Tab (Manual CMM) PowerINSPECT 
 
 

 

Calibration 
 

Expand the Calibration Tab  
 
 

 
 

The current diameter of the calibration sphere is displayed here. This can be changed but 
only if the Head is calibrated first. 

 

• Select  
 
 

 
 
 

The overall settings for the calibration can be changed in this form. Leaving the settings as 
default, select OK. 

 
The Head must be calibrated first. 

 
• Highlight the Head-MH20i in the assembly tree  

• Select Calibrate selected item  
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The Probe Head calibration Wizard is lauched. As each stage progresses, the user is 
prompted with the required action. 

 
The first stage warns the user that this is a task that should only be undertaken by experienced 
personnel. 

 

 
 

• Select  
 

The next stage prompts the user to suggest the size of the calibration sphere. 
 

• Enter the size of the Calibration Sphere, and the vector direction of it’s 
normal (if asked). 

 

 
 

• Select  
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The next stage involves the creation of the Probe tool fitted to the Head. 
 

• Select the New Assembly (or if required, enter a new name and diameter) 
 
 

 
 

• Select 
 

The User is then prompted to enter the direction of the probe when it is at the A= 0, B = 0 
position. In this case it is directly down Z 

 
 

 
 
 

• Select 
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The wizard asks the user to probe the calibration sphere. 
 

• Choose Next to start the process. 
 

 

• Change if required, the Head angles to A=0, B=0 
 

 

• Select OK. 
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• Take at least 4 points around the sphere as shown 
 
 

• Select OK. 

• Change the Head angles to A=90, B=0. 
 

 

• Select OK. 
• Take at least 4 points 

 
 

 
 

• Select OK. 
• Change the Head angles to A=90, B=90. 
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• Select OK. 
• Take at least 4 points 

 
 

 
 
 

• Select to complete the calibration process. 

The assembly tree is now updated to reflect the calibration. The head and three positions 
used are calibrated and identified with a green tick. 

 

 
 

Currently, the position A:90 B:90 is highlighted in Bold. This denotes this active position. 

If a different position is required then it must be activated first. 

 
• Highlight position  

• Select activate selected item  
 
 

 

Copyright © 2009 – Delcam plc Issue PowerINSPECT 2010 10.13 



10. Machine Tab (Manual CMM) PowerINSPECT 
 
 

 

• Move the Head to the position requested. 

• Select OK 
 

 

Position A=0, B=0 is now ready to use. 
 
 
 

Adding Further probe positions 
 

Further probe positions can be added. 
 

• Highlight the New assembly in the tree. 
 
 

 

• Select Add new position  
 

New positions can be added to this form. 
 
 
 

 
 
 

Use the slider bars or enter directly the angles required. 
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• Enter A=45, B=45 

 

 

• Select Add to add it to the current list of positions. 
 

 

• Select OK to close the form 
 

The new position is now listed in the assembly tree. However it is indicated by 
a red cross identifying it as uncalibrated 

 
• Highlight the position  

• Select Calibrate selected item  
 
 

 
 

• Change the position of the probe to reflect A=45, B=45. 

• Select OK. 
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• As with the previous calibration, Take at least 4 points. 
 

 

 
• Select OK 

 

 

• Select Finish to close the form 
 

The new position is calibrated and active ready for use.  
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11. PowerINSPECT OMV Demo  
 
 
1. Create a new session using the knife.dgk CAD file 

 
The CAD view manipulation is now the same as the other products. 

 
 
2. Set up the simulator 

 
If you have a machine tool already set up, you should use what is 
available. Otherwise the recommended setup for demonstration 
purposes is an MP700 with a 100mm long, 6mm diameter stylus. 

 
Set this in the Simulator tab.  The simulator is behind the Sequence tree. 
Set it up to use No_Model mtd file, MP700 and the M4_100x6_CE stylus 
(this represents M4 connection, 100mm nominal length, 6mm nominal 
diameter ball, ceramic construction.) 

 

 
 
 

3. Preparation 
 
Reset the PCS 



 

 
 

Delete any transformations that have been set up. 
 
Show the CAD view, rotation etc. Move the probe around using the 
‘Manipulate Probe’ button. 

 

 
 
You can move the probe assembly by selecting the stylus with the left 
mouse button. ALT with left mouse will limit the movement to the CAD 
principal axes. 

 
Create a geometric group. 

 
 
 

4. Probed Plane 
 
Create a plane on the top surface using the Probed Plane icon. 



 

 
 

In the CNC panel, this will create a probed plane. 
 

 
 
The strategy will be User Defined. This means that the probe path is 
generated by clicking points on the model. 

 
Click the points on the model around the top plane, and commit the 
probe path. 



 

 
 
 

4.1 Editing the Probe Path 
 
When you have committed the probe path, you can edit it by pressing 

the ‘recycle’ button.  
 
 
 

4.2 Lead in and Lead Out 



You can change the Lead in and Lead out using the Safe Plane button. 

 
 

Pressing the icon  turns the behaviour on and off.  The number is 
the safe plane distance. A value of 40mm will allow you to clear the top 
of the model. 

 
 
4.3 Simulating the strategy 

 
When the plane is correct, you can show the movement of the probe 

using the ‘simulate strategy’ button.   You can use this in conjunction 
with the View- Simulator commands, or the keyboard shortcuts F9, F10, 
F11 which show and hide the machine, the head, and the stylus. 

 
 

5. Probed Line 
 
Create a probed line using the probed line button. 



 

 
 

Again, this will create a feature with a user strategy. 
 
Click points on the edge of the model to create a probed line. 

 

 
 
Set a safe plane distance of 40mm again, to ensure that you clear the top 
of the model. 

 
 
5.1 Converting from a User Strategy to an Auto Strategy 

 
With most geometric features, you can change between a user strategy 
(clicked points) and an auto strategy (automatically distributed points.) 



This useful because 
- an auto strategy can ‘tidy up’ the probe path from a user strategy 
- a user strategy can take an auto strategy as a starting point 

 
To change from the user strategy to the auto strategy, edit the feature 
and change the strategy from User Defined to Auto Touch Trigger. 

 
 
When you do this, the geometry of the feature will be unchanged, but 
the probe path will be spread evenly along the feature. 



 

 
 
 

5.2 Changing the method 
 
There are two methods for this feature- SlicesPitch and Slices Points 

 
SlicesPoints defines the probe path in terms of the number of 
points. SlicesPitch defines the probe path in terms of the distance 
between the points. 



 

 
 
 

5.3 Changing the number of points 
 
You can change the number of points used in the feature by pressing the 
strategy editing button. 

 

 
 
This will raise a dialog where you can edit the parameters for the probe 
path, including the number of points. 

 
Edit this to the desired number of points. 



 

 
 
 
 

5.4 Changing the Probing Depth 
 
You can change the probing depth- the depth into the plane- using the 

probing depth icon.   
 

Pressing the button toggles this parameter on and off.  The number in 
the field is the depth dimension. 

 

 



6. Probed Circle 
 

Use the wireframe checker  to select geometry from the CAD model. 

By default, the wireframe checker is in ‘wireframe’ mode.  This is used to 
pick complete 2D features such as circles. You can check this by ‘right 
clicking’ in the CAD view. 

 
Surface is used to select complete 3D features, such as 
cylinders. Wireframe is used to select complete 2D features, 
such as circles. 
Simple wireframe is used to select partial 2D features, such as the 
semicircles at the end of a slot. 
Point are used to select single points, which can be built into other features 
by picking more than one point. 

 

 
 
In Wireframe mode, move the cursor over the model and you will see that 
geometry is highlighted as you more over a particular feature are shown. 



 

 
 

Pick the circle, and PowerINSPECT will create a feature with a probe path. 
Set the probe safe distance to 40mm, and set the probing depth to 
40mm. 

 

 



7. Creating the Alignment 
 
Go up to the definition level, and create a PLP alignment based on these 
three features. 

 
 
The plane sets the Z 
orientation. The line defines 
the X axis. 
The centre of the circle defines a point for positioning. 

 
 
8. Simulating the Measurement 

 
You can simulate the measurement of a group of features- and see 
simulated results- by using the Program Runner with the Simulated 
Measure.  The play, rewind and stop buttons etc allow you to see the 
movement of the probe throughout the sequence. 

 

 
 
This simulation will also give you simulated results. 



 

 
 

 
8.1 Simulating a Partial Sequence 

 
You can set range markers to mark the start and stop of the range for 
simulation. 

 

 
 
Set the start and end of the range. The features will be marked with a 
series of arrows, to indicate whether they are included in the current 
range. 



 

 
 
 

8.2 Showing and Hiding Probe paths 
 
You can set which probe paths you want to display using View- CNC Probe 
Paths. 

 
 
9. Creating an NC Program 

 
You can create an NC Program using the OMV tab. 

 

 
 

The export button  allows you to export an NC program.  This 
brings up the export Window. 



 

 
 

Choose the appropriate postprocessor and choose the name for 
the file. Set the output probe point to Tip. 
Select the Tool Number, the name of the NC program, and the Workpiece 
Coordinate System number. (On Fanuc and Siemens this equates to 
G54, G55 etc.) 

 
 
9.1 Transferring the program to the CNC controller. 

 
The method will depend on the Controller. 
On Siemens 840D you may be able to export directly to the controller, if 
you have networked onto the location. 
You may be able to transfer the NC program to disk etc, and then copy to 
the controller. 
On simpler Fanuc controllers you will probably use WinDNC. 

 
 
 
 
9.2 Setting up the import for results. 

 
This depends on whether you are using a serial or file connection. 

 
In either case, press the Configure Import button to display the Import 
Configuration dialog. 



 

 
 

In any case, use for the CLDATA file the file that you used for the NC 
export. This should match the CLDATA file created in Section 9 above. 

 

 
 
Then select the Import script.  This will either be serial or from file. In the 
case of the serial import, you will have to set the communication 
parameters. 



 

 
 

Alternatively, this will be from file, in which case you will have to identify 
the results file. 

 
 
 
9.3 Running the Import 

 
When the configuration has been set up, you will be able to run the import. 

 
 
Run the import using the play button. 

 

When the import is ‘live’ you will be able to stop or pause the import using 
the other two buttons. 

 
Before Import, make sure that the Measure is set to Master Part. 



10. Creating a Surface Inspection Group 
 
Create a surface inspection group using the Surface Inspection Group 

button.   
 

This will automatically create a user method. 
 
Create the first couple of points on the main surface. 

 

 
 
Then in the CNC tab, change the method from CMM to Machine Tool. 



 

 
 

Set the method to Machine Tool, and set the safe plane height to 40mm.  
This means that the probe will come up to a plane 40mm above the 
surface between each point. 

 

 
 
This means that it is easier to avoid collisions. Create a few points 
around the model and save the strategy. 



 

 
 
 

11. Slot 
 
Create another Geometric Group, and select the slot. Set the safe plane to 
40mm, and set the probing depth to 3mm. 

 
You will notice that the slot is created with a reference plane. 



 

 
 

This is because the slot by default has a ‘body panel’ strategy, which uses 
a separate reference plane for each feature, even if a suitable plane 
already exists. 

 
 
The ‘Associate Plane’ flag means that a new ‘linked’ plane will be created 
for each 2D feature of this type. 

 
You can change this behaviour in the session by changing the strategy for 
the item, or permanently by editing the strategy file.  This is called 
piStrategyOMV,xml, and is installed in the 
dcam\product\PowerINSPECTXXXX\CNCData directory. 



 

 
 
 

12. Circle 2 
 
Create a second circle, this time using a different number of points (use 
the strategy button to do this.) 

 

 
 
 

13. Cylinder 
 
In the Wireframe Checker, change to surface mode to allow you to pick 
3D features, such as cylinder and cones. Right click in the CAD view, 
and select Surface. 



 

 
 

Select the cylinder in the model (pick on the wireframe lines, rather than 
in the spaces) and pick the cylinder. 

 

 
 
Edit the height of the cylinder, so that the upper height is 15 and the 
lower height is 5. This shortens the probed cylinder. 
Edit the probing depth, and change this to 2 mm.  This brings in the 
probed points from the end of the feature. 
Finally, set the probe safe plane is 10mm. 



 

 
 
 

14. Intermediate Path. 
 
Create an intermediate probe path. 



 

 
 

This allows you to create a probe path as a user method, but the points 
are not actually probed on the surface- they are offset from the model by 
a distance which is set by the ‘probe safe plane’ parameter. 

 
Create an intermediate path going from the main plane to the top of the 
model near the cone.  You can also edit the probe path by moving the 
points with the cursor. 



 

 
 
 

15. Cone with modified probe path 
 
Now create the cone on the top of the model. 



 

 
 

Although the cone is created properly, you will notice that some of the 
points are very near the ends, or actually in space. 

 
We will modify the cone to use a user strategy, and manually move the 
points to a better location. 



 

 
 

Change the method to User Defined, and then you will be able to move 
the probed points manually. 



 

 
 

The auto strategy can be converted to a user strategy and vice versa. 
 
 
16. Cylinder with modified probe path 

 
Pick the cylinder on the top of the model. As before, change the height 
of the cylinder so that only the top 10-15mm is used. Then, as with the 
cone, edit the method from Auto Touch Trigger to User defined, and 
move the points so that they stay on the surface. 



 

 
 
 

17. Sphere 
 
This time, we will start with a User Defined Strategy and change to an auto 
touch trigger. 

 
Select the Sphere as a Probe Sphere from the interface. 



 

 
 

Change the method to User Defined 
 

 



Now delete the automatically created probe path using the ‘remove point’ 
 

button. 
 

Do this until the counter is empty  
 

Now place 4 points on the sphere.  When you pick 4 points, the sphere 
should be recognised. 

 
 
Next change the method from user defined to Auto Touch Trigger.  This 
will distribute the points evenly on the feature. 



 

 
 

Now you have to fix the orientation using the ‘inverse probe path button’. 
 

 
 
Finally, move the boundaries to 90 degrees and 10 degrees, to take 
account of the bounding of the intersecting surfaces. 



18. Remaining Geometry 
 
Create an intermediate path from the sphere to the front edge, followed by 
lines (or planes) around the outer faces. 

 

 
 

19. Surface Inspection with CMM Strategy 
 
Finally, create one of more inspection groups using the CMM strategy. 

 
As with the Machine Tool strategy, this is a user strategy- you pick the 
points individually- but this time the points will skim the surface. This 
means that you have to be more careful to avoid collisions. 

 
To help avoid collisions, you can create intermediate points using the 
SHIFT key while double-clicking the points.  This will create an 
intermediate point away from the surface- as with the intermediate 
probe paths- and as before you can manually change this distance by 
pulling the points.



 

 
 
 

20. Showing OMV Import 
 
With the files on the demo CD, you can show the OMV import using points 

from file. Copy the files from the OMV_Documentation\Demo\4025Demo 

directory. 

In the OMV tab, use the reader_psfixtureFile.rsf file (this is installed with 
PowerINSPECT in the dcam\product\PowerINSPECT4025\OMVReaders 
directory. 

 
For the CLDATA file, use the Demo4025.cxm file. 

 
For the data input, use the OMV_MSR_4025Demo.mpf file. 



 

 
 

Press the ‘play’ button on the OMV import, and this should read in the data as 
below. 
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